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Introduction: 

We are in the age of Digital Revolution which has opened up many possibilities and options to redefine 

our strategies and the way we think. This phenomenon is also true when it comes to designing premium 

photo albums. So, why not get the digital advantage and come out of the same mundane looks of 

conventional photo albums? 

Introducing DG Foto Smart, a Fast and Easy Digital Album Creation Tool, which helps you in creating 

designer albums for your premium customers who demand the world... its time you give it to them.  

DG Foto Smart is a complete and stand-alone software requiring no third party tools or any artistic skills 

for creating exclusive album pages within minutes. 

So if you are looking to capture the beauty of a wedding, the fun of a family vacation or any other 

occasion and to preserve these precious memories in a digital way, DG Foto Smart gives you 

incomparable tools all guaranteed to help you produce exclusive and stylish album which will be 

cherished for a lifetime. 

DG Foto Smart helps you increase productivity and make big profits because of its ease of operation and 

the numerous templates, decors and tools it is bundled with. 

What's New in this DG Foto Smart Version? 

Comparison with Dg Foto Art - Gold 

 Interface Change 

 The software is built on a new technology and the interface is revamped with some iconic 

changes 

No Dongle  

 This software will work without dongles. 

 It will require internet during  Registration and while Export. 

 All Properties on All Objects 

 You can now apply almost all available properties on all objects like Images, Clipart, Borders etc.  

Create Covers 

 Along with the Projects DG Foto Smart also provides you the option to create Cover in the Same 

Project. 

mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Understanding_the_User_Interface.htm
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 You can specify if it is just a Front Cover or Front and Back Cover along with the other properties 

for the Cover 

 You can also specify a Spine Width to the cover 

New Page Display 

 You can now select a Page Display between Individual Pages or Spreads 

Safe Area 

 Now you can simply mention one value of safe area and apply the same to all others 

Preview for Sizes 

 Now you can see a preview of the page and the cover while selecting the sizes for page and 

cover 

  Generate Preview 

 You can create a preview of your project and view it. It also has the option to autoplay 

 Preview for Themes 

 You can preview the themes before applying it to you projects 

Improved Story Board  

 New Improved Storyboard 

 

Online Cropping 

 DG Foto Smart provides online cropping of Objects. 

 You don’t have to go to a crop mode any more. Simply crop the photo by dragging the center 

points of the photo 

Zooming 

 Zoom an Object without compromising the size of the photo on a page 

Panning 

 Now you can adjust the Object which is zoomed or cropped on the page itself 

 Improved Gallery 

mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Dg_Slide_Show_Generation.htm
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 Template Gallery and Other Galleries are included in Gallery Window. 

 Click on the required gallery to load its respective library 

Adjustable Gallery 

 The Gallery window is now adjustable, you can adjust to the required size to view more 

thumbnails 

Zoom Canvas 

 You can now zoom a canvas page and also move to a particular portion on the zoomed page 

Layouts 

 DG Foto Smart provides a Huge Library of Layouts 

Shapes 

 Vector Shapes are provided in DG Foto Smart 

 You can apply almost all properties to these shapes 

Presets 

 Huge Library of Presets have been introduced in DG Foto Smart for different functionalities like 

outline, tones shadows etc 

Text 

 Now you can type a Paragraph 

 Increase the Size of the Text Box.  

 Text get automatically adjusted in the Text Box 

 You can also Left, Right, Center and Justify the Text 

 You can apply multiple outline and glow to the text 

Collages 

 DG Foto Smart provides you a simplest way to design impressive collages with variety of options 

Flipping 

 DG Foto Smart Allows you to individually flip Object, Background, Frames and Masks 

 



Approval 

 You can generate low resolution files with watermarks. These files can be send to you customers 

for getting approvals for your designed pages 

Export 

 The Export gallery is enlarged and now displays more thumbnails 

 You can open the exported pages folder from the software 

Spilt option 

 You can add additional bleed to your split pages 

  

System Requirements 

Before using DG Foto Smart, we recommend you to go through this section and read about the 

Minimum System Requirements to extract the maximum out of the application. 

For Windows: 

 Minimum  

 CPU - Intel i3 2nd Gen 

 RAM - 4 GB 

 HDD Free Space - 10 GB 

 Windows version - 7.0 / 88.1 / 10.0 

 Screen Resolution - 1366 X 768 (16:9) 

Recommended  

 CPU - Intel i5 or above and equivalent 

 RAM - 6 GB 

 HDD Free Space - 10 GB 

 Windows Version - 8 & above 

 Screen Resolution - 1920 X 1080 (16:9) 

mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Exporting_Pages.htm
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For MAC: 

Minimum  

 CPU – Intel Core 2 Duo  

 RAM - 4 GB 

 HDD Free Space - 10 GB 

 OS version – 10.10 & Above  

Recommended  

 CPU - Intel i5 or above and equivalent 

 RAM - 6 GB 

 HDD Free Space - 10 GB 

 OS version – 10.10 & Above  

 

Understanding the User Interface 

The various topics under this section will introduce you to the User Interface of DG Foto Smart and you 

will get acquainted with its various sections. 

You can start DG Foto Smart by clicking Start -> All Programs -> and then selecting the DG Foto Smart 

icon  

Or you can simply double-click this icon  on the desktop. 

Different Sections in Interface 

DG Foto Smart interface is divided into the following logical sections: 



 

 

A. Title Bar 

B. Menu Bar 

C. Toolbar 

D. Content Toolbar for Backgrounds 

E. Content Toolbar for Image 

F. Library 

G. Story Board 

H. Effects Toolbar 

 

To find more about these sections, read further in the following chapters or simply click any of the 

above links. 

Menu Bar 

The Menu bar provides frequently used options. This is a drop-down control containing the various main 

menu items. Some of the options under these menus are also provided as icons below the Menu bar.  

In the following sections, these main menu items are explained. 



 

The various Menu options are:  

 File 

 Edit 

 View 

 Insert 

 Format 

 Object 

 Help 

File 

 

 The File menu contains the following options: 

  

Menu Item Function 

New Project Opens a new project 

mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/File.htm
mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Edit.htm
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Open Project Opens an existing project 

Close Project Closes the current project 

Save Project Saves the changes to the project 

Save Project as  Saves the project with a new name 

Save as Template Saves designed pages as templates 

Save as Layout Saves the current design as Layout 

Change Page Properties Changes the page dimension of a designed project 

Project Information Displays the project level information like number of pages, 

spreads, number of unique Images, page dimensions, Project Size 

and path 

Page Information Displays the page level information like page number, number of 

unique Images, dimensions and path 

Image Information Displays the image size, DPI and other related information 

Export Converts the Project into a printable format like JPG, PDF. 

Preferences Loads different settings for the software 

Exit Closes DG Foto Smart 

  

 

 

 

Preferences 

 

Menu Item Function 

Project Workspace Changes the path of the set working directory 



External Editor Opens the External Editor 

Set Safe Area Color Changes the color of the Safe Area on Canvas 

 

Keyboard Shortcut Function 

ALT+F Activates the File menu 

   

Edit 

 

 

This Edit menu consists of the following Items: 

 Menu Item Function 

Cut Cuts an object from the page for pasting somewhere else 

Copy Creates a copy of an object for pasting it somewhere else 

Paste Pastes the object last copied or cut  

Undo Undoes the last change done 

Redo Redoes the last change done 



Delete Deletes the currently selected object 

Lock  
Locks an object so that it does not move while 

composing  

Unlock 
Unlocks a Lock object so that it can be moved while 

composing 

Select All Selects All Objects on the current Page 

Set Background Color Provides option to set Background Color 

Flip Page Horizontally Flips the current Page Horizontally 

Flip Page Vertically Flips the current Page Vertically 

Open Libraries Opens Various Libraries 

Tools Opens various Tool options 

 

Open Libraries 

 

  

Menu Item Function 

Images Displays Images  in Library 

Clipart Displays Cliparts in Library 

Frame Displays Frames in Library 

Mask Displays Masks in Library 



Background Displays Backgrounds in Library 

Shape Displays Shapes in Library 

Layout Displays Layouts in Library 

Template Displays Templates in Library 

StoryBoard Displays the pages of the Project 

 

 

Tools 

 

Menu Item Function 

Adjust Option to Adjust the Image(s) 

Shadow Option to apply Shadow to Image(s) 

Stroke Option to apply stroke to Image(s) 

Glow Option to apply Glow to Image(s) 

Filters Option to apply Filter to Image(s) 

Text Option to apply Text to Images(s) 

Presets Option to apply Effects on Image(s) 

Align Option to Align Image(s) 



Edit Option to Edit the Image(s)  

Collage Option to create Collage 

External Editor Option to add Third party Editor to edit Image(s) 

 

Keyboard Shortcut Function 

ALT+ E Activates the Edit Menu 

  

 

View 

         

This View menu consists of the following menu items: 

Menu Item Function 

Preview Generates and Plays the Preview of the Project 

Fit to Screen Resizes the page in to fit in the window screen 

Full Screen Displays the work area in full screen 

Previous Page Loads the Previous Page 



Next Page Loads the Next Page 

Safe Area Turn Safe Area on/off on Canvas 

Center Line Turn Center Line on/off on Canvas 

Ruler Show/Hide Ruler on Canvas 

Show Grid Show/Hide Grid on Canvas 

Guides Show/Hide Guidelines on Canvas 

Show Tool Library Show/Hide Tool Libraries Window on Canvas 

Show Tool Gallery Show/Hide Tool Gallery Window on Canvas 

Show Layers Displays list of Layers on Canvas 

 

Keyboard Shortcut Function 

ALT+ V Activates the View menu 

 

Insert  

 

Menu Item Function 

Text Adds TextBox on the Page 

Blank Page Adds a Blank page at the end 

Photo as BG 

Turns the selected photo into a Photo 

Background 

Collage Provides Different Options for Colleges 

 

Collage 



 

Menu Item Function 

New  Collage Adds a Place holder to create a new collage 

Convert Collage 
Creates a collage using the selected Images on 

canvas 

Break-up Collage Breaks the selected collage  

Random Rotate Rotates the Images in Collage in random direction 

Shuffle Collage Shuffles the Images in the Collage 

 

 

 

 

Format 

 

This Format menu consists of the following menu items: 

 Menu Item Function 

Change Theme Loads the Change theme window to choose a New 

Theme 

Shuffle Page Layouts Loads different styles of Layouts on the Current Page 

 

Keyboard Shortcut Function 

Keyboard Shortcut Function 

ALT+ I Activates the Insert menu 



ALT+ O Activates the Format menu 

 

Object 

 

This Object menu consists of the following menu items:  

Menu Item Function 

Align Provides Alignment Option for Objects 

Copy Properties Copies Properties from on Object  

Paste Properties Pastes the Properties to the Object 

Clear Properties Removes all the Properties applied to the Object 

Swap Image Swaps two Images 

Remove Frame Removes Frame from the Object 

Remove Mask Removes Mask from the Object 

Link Links (Groups) Multiple Objects 

Unlink (Ungroups) the linked Objects 

Identical Size Different options to apply identical sizes on 



Objects  

Arrange Changes the positions of these objects 

Distribute Provides various options of Spacing between 

Objects 

  

  

  

  

Align 

 

 

Menu Item Function 

Safe Area Base 

Aligns the selected object within the Safe Area of 

Page 

Object Base 
Different options to apply alignment as per the 

Object 

Page Base 
Different options to apply alignment as per the 

Page 

 

 

 

 

Object Base 



 

Menu Item Function 

Left 
Aligns the selected object with the left edge of 

the last object selected 

Right 
Aligns the selected object with the right edge of 

the last object selected 

Top 
Aligns the selected object with the top edge of 

the last object selected 

Bottom 
Aligns the selected object with the bottom edge 

of the last object selected 

Horizontal and Vertical Center 
Aligns the selected object with the Center of the 

last object selected 

Horizontal Center 
Aligns the selected object with the Horizontal 

Center of the last object selected 

Vertical Center 
Aligns the selected object with the Vertical 

Center of the last object selected 

 

Page Base 



  

Menu Item Function 

Top Left 
Aligns the selected object to the Top Left Corner 

of the page 

Top Center 
Aligns the selected object to the Top Center of 

the page 

Top Right 
Aligns the selected object to the Top Right Corner 

of the page 

Center Left 
Aligns the selected object to the Left Center of 

the page 

Horizontal and Vertical Center 
Aligns the selected object to the Center of the 

page relative to the current position 

Center Right 
Aligns the selected object to the Right Center of 

the page 

Bottom Left 
Aligns the selected object to the Bottom Left 

Corner of the page  

Bottom Center 
Aligns the selected object to the Bottom Center 

of the page 

Bottom Right 
Aligns the selected object to the Bottom Right 

Corner of the page 

Top Aligns the selected object to the Top of the page 



relative to the current position 

Bottom 
Aligns the selected object to the Bottom of the 

page relative to the current position 

Left 
Aligns the selected object to the Left Corner of 

the page relative to the current position 

Right 
Aligns the selected object to the Right Corner of 

the page relative to the current position 

Horizontal Center 

Aligns the selected object at the center on 

vertical axis of the page maintaining the current 

horizontal line 

Vertical Center 

Aligns the selected object at the center on 

horizontal axis of the page maintaining the 

current vertical line 

 

Identical Size 

 

Menu Item Function 

Height 
Sets two or more selected Images to the same 

height as the last selected photo 

Width 
Sets two or more selected Images to the same 

width as the last selected photo 

Width and Height Both 
Sets two or more selected Images to the same 

Width and Height  as the last photo 

 

 

 

 



Arrange 

 

Menu Item Function 

Bring to Front Moves the object to the front most layer 

Bring Forward Moves the object in front of another object by one level 

Send Backward Moves the object behind another object by one level 

Send to Back Moves the object to the back most layer 

 

Distribute 

 

Menu Item Function 

Top Edges It Spaces the Images with respect to the Top Edges of the Images 

Vertical Centers It Spaces the Images with respect to the Vertical Centers of the Images 

Bottom Edges It Spaces the Images with respect to the Bottom Edges of the Images 

Left Edges It Spaces the Images with respect to the Left Edges of the Images 

Horizontal Centers It Spaces the Images with respect to the Horizontal Centers of the Images 

Right Edges It Spaces the Images with respect to the Right Edges of the Images 

  

 



Help 

 

This Help menu consists of the following menu items:    

Menu Item Function 

User Manual Opens the Help file 

Shortcut Keys Opens the list of Shortcut Keys 

About Displays details about the software version, technical 

support, etc. 

Software Update Checks for any new software updates/ upgrades 

Galleria Update Checks for any new Theme updates 

Regenerate Thumbnails Regenerate the thumbnails in Library in case of missing 

assets. 

Verify page Verifies Page if any assets are missing. 

Backup Projects Takes a Backup of Current Project including all the assets 

(material, Images, etc.) 

Restore Projects Restores the backup project 

Purchase/Renew Subscription Option to Purchase/Renew Subscription 

Support Center Displays contact details of Support Center 



  

 

Toolbar 

 

The toolbar contains the graphical representation of the tools often used during Album or project 

creation. These tools act as shortcuts for easy access during the various operations of DG Foto Smart. 

The toolbar icons are shown below along with their graphical representation. 

Button 

Name Icon 

Function 

New 

 

Opens a new project 

Save 

 

Saves a project 

Open 
 

Opens an existing project 

Undo 
 

Undoes the last action  

Redo 
 

Redoes an undone action  

Cut 

 

Cuts a photo or any other object for pasting somewhere else on a 

page 

Copy 

 

Copies a photo or any other object from one place for pasting it in 

some other area 

Paste 
 

Pastes a photo or any other cut or copied object 

Shuffle 

 

Shuffles the Layout on the current page 

Change 

Theme  

Loads the Change theme window to choose a New Theme 



Full Screen 
 

Displays the work area in full screen 

Fit to 

Screen  

Fits the work area in the default application screen 

Open 

Exporter  

Opens Exporter for exporting the Project. 

Preview 
 

Creates and Starts the preview of a Project 

Home 
 

Takes to Homepage of the Application 

 

Content Toolbar on Backgrounds 

 

Content Toolbar appears when you select a Background or an Object 

The toolbar contains the graphical representation of the tools used during  various operations for   

Backgrounds and Objects on Canvas in DG Foto Smart. 

These tools act as shortcuts for easy access during the various operations. 

The toolbar icons are shown below along with their graphical representation. 

Button Name Icon Function 



Editor 

 

Opens the Background in External Editor 

Bg Color 

 

Opens the Fill Color Window to add a Background 

Color 

Flip 

 

Opens the Option to do Various Flip Functionalities 

for Backgrounds 

Flip Vertical 

 

This Option under Flip will Flip only the Background 

Vertically and not the Mask applied to it 

Flip Horizontal 

 

This Option under Flip will Flip only the Background 

Horizontally and not the Mask applied to it 

Opacity 

 

Change the Background Opacity 

Properties 

 

Loads the Copy/Paste or Clear Image Properties 

options 

Copy Properties 
 

Copies all the Properties applied to a Background 

Clear Properties 
 

Clear all the properties applied to a Background 

Reset 

 

Resets to the original state of Background  

Masks 

 

Will be active only if a Mask is applied on the 

Background. It opens the Options to do various 

function for Masks applied on Background 

Flip Vertical 

 

This Option under Masks, will flip the Mask 

Vertically without flipping the Background Image 

Flip Horizontal 

 

This Option under Masks, will flip the Mask 

Horizontally without flipping the Background Image 

Remove Mask 

 

This Option under Mask removes the Mask applied 

on the Background 

Delete 

 

Removes the background from the page 



 

 

Content Toolbar on Image(s) 

 

The toolbar contains the graphical representation of the tools used during for various operations of  

Image on Canvas in DG Foto Smart. 

These tools act as shortcuts for easy access during the various operations. The toolbar icons are shown 

below along with their graphical representation. 

Button Name Icon Function 

Create Collage 

 

Enables the Collage 

Functionality  

Break Collage 

 

This Button will toggle with 

Create Collage button. This will 

break the created collage 

Create Individual 

 

This button will be active only 

when you are in collage Mode. 

By clicking on this Button you 

can select an Individual Image 

in a Collage and apply various 

features to individual Images 

Shuffle 

 

This button will be seen only in 

Collage Mode. This will shuffle 

the Images in Collage 

Collage Rotate 

 

This button will be seen only in 

Collage Mode. This will load 

options for Collage Rotate 

Collage Rotate 

 

This Button will be under 

Collage Rotate. This will rotate 

the Images inside the Collage 



Reset Collage 

 

This Option will be seen under 

Rotate Collage. This will reset 

the Rotation applied on the 

Collage 

Editor 

 

Opens the Selected Image in 

External Editor  

Arrange 

 

Opens the Arrange Options 

Bring to Front 

 

This option Under Arrange 

moves the Object on top of all 

other Objects 

Send to Back 

 

This option Under Arrange 

moves the Object to the Back 

of all other Objects 

Send Backward 

 

This option Under Arrange 

moves the Object one step 

Back of the other Object 

Bring Forwards 

 

This option Under Arrange 

moves the Object one step 

Forward of the other Object 

Flip 

 

Opens the Flip and Rotate 

Object options  

Flip Vertical 

 

This Option under Flip will flip 

the Object Vertically. Masks or 

Borders applied to the Object 

will not flip 

Flip Horizontal 

 

This Option under Flip will flip 

the Object Horizontally. Masks 

or Borders applied to the 

Object will not flip 

Rotate 180 

 

This Option under Flip will 

Rotate the Object at 180 

degrees Angle 



Rotate 90 Clockwise 

 

This Option under Flip will 

Clockwise Rotate the Object at 

90 degrees Angle  

Rotate 90 Counter 

Clockwise  

This Option under Flip will 

Rotate the Object at 90 

degrees Angle Counter 

Clockwise 

Opacity 

 

Changes the Opacity of the 

Object  

Properties 

 

Loads the Copy/Paste or Clear 

Image Properties options 

Copy Properties 

 

This option under Properties, 

Copies all the Properties 

applied to a Object 

Paste Properties 

 

This option under Properties, 

Pastes all the Properties copied 

from another Object to the 

Selected Object 

Clear Properties 

 

This option under Properties 

will clear all the properties 

applied to the Object 

Lock 

 

Locks the selected Object 

Unlock 

 

Unlocks the Lock Object 

Swap Photo 

 

Swaps the position of 2 

Selected Images 

Reset 

 

Resets to the original state of 

Object  

Frames 

 

Will be active only if a Frame is 

applied to the Photo. It opens 

the Options to do various 

function for Frame applied on 



Object 

Remove Frame 

 

This Option under Frames 

removes the Frame applied on 

the Photo 

Flip Vertically 

 

This Option under Frames, will 

flip the Frame Vertically 

without flipping the Photo 

Flip Horizontally 

 

This Option under Frames, will 

flip the Frame Horizontally 

without flipping the Photo 

Masks 

 

Will be active only if a Mask is 

applied to the Photo. It opens 

the Options to do various 

function for Frame applied on 

the Object 

Remove Mask 

 

This Option under Mask 

removes the Mask applied on 

the Photo 

Flip Vertical 

 

This Option under Masks, will 

flip the Mask Vertically without 

flipping the Photo 

Flip Horizontal 

 

This Option under Masks, will 

flip the Mask Horizontally 

without flipping the Photo 

Shape Color 

 

This will be active only when a 

shape is selected. It provides 

the Option to add colors to the 

Shape 

Group 

 

This Option is seen when more 

than one Object are selected. It 

automatically groups all the 

Objects 

Ungroup 

 

This Option Ungroups the 

Grouped Objects 



Delete 

 

Removes the Object from the 

page 

 

Buttons & Icons Section  

The buttons used during template creation are organized and placed under their respective sections for 

quick access.  

The brief description of these buttons is as follows:  

Button Name Icon Function 

Rotate Photo 

 

Rotates the Image 

Rotate inside 

Photo  
 

Rotates Image inside Border, Masks or Crop Area 

Zoom in/out 

 

Zoom in or Zoom Out a Photo inside Border, 

Masks, Crop Area or Outline 

Panning 

 

Adjusts the photo inside Crop Area 

Add to Collage 
 

Adds selected Images to collage 

Flip Page 

Vertical  

Flips Page Vertically  

Flip Page 

Horizontal  

Flips Page Horizontally 

Hide  Library 

 

Minimizes the Library 

Minimize 
 

Hides the Gallery Window 



Maximize 

 

Shows the Hidden Gallery Window 

Add Page  

 

Adds a blank page into the work area and also the 

Story board 

Delete Page  

 

Deletes the current page from the work area and 

also the Story board 

Zoom 

 

Zooms Canvas 

Page No  

 

Displays the page number and total no template 

pages in the project 

Next  

 

Navigates to the next page in the project 

Previous 

 

Navigates to the previous page in the project  

Image 

 
 

Displays Images and its categories or folders in the 

gallery 

Clipart 

 
 

Displays Clipart Library and its categories or 

folders in the gallery 

Frames 

 

 
Displays Frames Library and its categories or 

folders in the gallery 

Masks 

 

 
Displays Masks Library and its categories or 

folders in the gallery 

Backgrounds 
 

Displays Background Textures Library and its 

categories or  folders in the gallery 

Shapes  

 
 

Displays Vector Shapes Library and its categories 

or  folders in the gallery 



Layouts 
 

Displays Layouts Library and its categories or 

 folders in the gallery 

Templates 
 

Displays Templates Library and its categories or 

 folders in the gallery 

Library 

 

This Tab will be seen in Gallery Window where DG 

Foto Smart provides default Material 

User 

 

This Tab will be seen in the Gallery Window where 

you can download your own Images and designing 

material like Cliparts, Backgrounds, Masks, etc 

Create 

Category  

This button will be seen in the Gallery Window. It 

Creates a new Category 

Import 

Directory  

This button will be seen in the Gallery Window. It 

Imports Directory which contains material. The 

Name of the Folder will be displayed in the Drop 

Down Under the User Tab 

Import a File 

 

This button will be seen in the Gallery Window. It 

Imports Material(s) in the selected directory or 

Category 

Delete 
 

This button seen in the Gallery Window will Delete 

selected file 

View Options  

 

This button will be seen in the Gallery Window. It 

provides Options to view Material with Filename 

and Tooltip which contains Photo Information 

Library View 

Settings 

 

This buttons will be seen under view options in 

Gallery Window. It provides option to view the 

library material wih Filename and Tooltip which 

contains object  information  

Sort Options 

 

This button will be seen in the Gallery Window. It 

Sorts File by Name, Size, Orientation, Time and 

Used 

Set as 

Background  

This button will be seen in the Gallery Window. It 

Sets the selected photo as a background photo 



Rotate 

Selection  

This button seen in the Gallery window provides 

the Rotation options for the selected objects 

Rotate Left(-

90)  

This button under Rotate Selection will rotate the 

selected object at 90 degrees on the left 

Rotate 

Right(90)  

This button under Rotate Selection will rotate the 

selected object at 90 degrees on the right 

Rename 

Category  
This button will be seen in the Gallery Window. It 

Edits the selected Category Name 

Remove 

Folder  

This button will be seen in the Gallery Window. It 

Deletes the selected Folder of Images from the 

Gallery.  

Small 

 

This button will be seen in the Gallery Window. It 

provides option to View Small Thumbnails 

Big 
 

This button will be seen in the Gallery Window. It 

provides option to View Large Thumbnails 

Favourites 
 

This button will be seen in Gallery Window. It 

provides option to select any object as Favourite. 

Editor 

 

This button will be seen in Gallery Window. It 

provides option to open the external Editor. 

Save Layout 

 

This button is seen in the Layouts Gallery. It Saves 

the current page as layout 

Save Template 

 

This button is seen in the Templates Gallery. It 

Saves the current page as template 

 

 

Library Section 

 



The Library section displays objects like Images, Backgrounds, Cliparts, Masks, Frames, Shapes, Layouts 

and Templates depending upon the corresponding button clicked.  

There will be defaults materials for Backgrounds, Cliparts, Masks, Frames, Shapes, Layouts and 

Templates which are saved under the Stock Tab. 

You can download or save your own created material using the Add or Save Functionalities. These 

Material will be displayed under the User Tab 

The details of the Gallery are explained as below: Insert Icons for All buttons 

Button Library Section Displays 

Images 

 

Displays Images based on categories (folders) 

 

Clipart 

 

Displays a gallery of Clipart based on categories (folders) 

 

Frames 

 

Displays a gallery of Frames based on categories (folders) 

 

Masks 

 

Displays a gallery of Mask shapes along with its category (if any) 

 



Backgrounds 

 

Displays a library of Backgrounds in the Gallery 

 

Shapes  

 

Displays a gallery of Shapes based on categories (folders) 

 

Layouts 

 

Displays a gallery of Layouts based on categories (folders) 

 

Templates 

 

Displays a gallery of templates based on categories (folders) 

 

StoryBoard 

 

  

Story Board  

As you go on creating your Album/Project, the Cover and Pages also get added in an area known as 

Story Board, which displays these pages in thumbnail format.  

The pages from the Story Board can be loaded into the work area by simply double-clicking them. 

As you read on further, you will learn how to add and append a page to this Story Board.  



Effects Window 

The Effects window is placed on the right hand side of the Software. The Sub Window of Effects can be 

minimized by clicking on the Minimized button.                  

The Effects window is further divided into the following sections or Tabs:  

 

 

Section Contents 



Adjust 

 

CTRL + F2 

 

Displays various options to Adjust 

 Brightness 

 Hue 

 Contrast 

 Saturation 

Also have option to adjust Color on Image 

 Cyan <-> Red 

 Magenta <-> Green 



 Yellow <-> Blue 

 Greyscale 

There are also many default Presets for Adjustments 

Shadow 

 

CTRL + F3 

 

Displays various options for applying shadows to selected Objects. These options 

include: 

 Shadow Distance 

 Shadow Angle 

 Shadow Opacity 

 Shadow Softness 



 Shadow Color 

There are also many default Presets for Shadows 

Outline 

 

CTRL + F4 

 

 

Displays various options for applying 3 types of outlines viz. Inside, Outside and 

Center on a selected object. Each individual type of Outline shall also have controls 

like: 

 Outline Thickness 

 Outline Color 

 Outline Opacity 



There is a Blend Mode option too 

There are also many default Presets for Outline  

Glow 

 

CTRL + F5 

 

Displays various options for applying 2 types of Glow like Inside and Outside Glow 

on a selected object. Each individual type of Glow shall also have controls like:  

 Glow Size 

 Glow Opacity. 

There are also many default Presets for Glow  



Filters 

 

CTRL + F6 

S 

 

Displays various options for applying filters to selected object. These options 

include: 

 Blur 

 Sharpen 

 Feather 

 Opacity 

There is a Blend Mode option too 



There are also many default Presets for Outline  

Text 

 

CTRL + F7 

 

Displays Various Options viz. 

 Add text 

 Font Type 

 Font Size 

 Font Style 

 Font Color 

 Font Background Color 



 Font Opacity 

 Font Alignment 

Effects 

 

CTRL + F8 

 

Displays Presets for applying different types of tones on any Objects 

  



Align 

 

CTRL + F9 

 

Displays various options for Aligning Objects 

 Object Based Alignment 

o Aligns the object with the last object selected 

 Page Base 

o Aligns the selected object with referenbce of the page relative to 

the current position 

 Safe Area 

o Align the selected object inside the safe area of the page 

Alignment options are 

 Horizontal Left Align 



  Horizontal Center Align 

  Horizontal Right Align 

  Vertical Top Align 

  Vertical Center Align 

  Vertical Bottom Align 

  Vertical Middle - Horizontal Center Align 

It also has distribution feature 

 

Equal Spacing between selected objects 

 Vertical 

 Horizontal 

 



Edit 

 

CTRL + F10 

 

Displays Various options to perform on single or multiple objects 

 Position 

o X : 

o Y 

 Size 

o W 

o H 

o Units 



 Match Size 

o Same Width 

o Same Height 

o Same Width and Height 

 Rotate 

 Crop Shape 

o Radius 

Collage 

 

CTRL + F11 

 



Displays Various options to create a collage. The options are 

 Create Collage 

 Collage 

 Width 

 Height 

 Units 

 Shuffle  

 Rotate 

 Reset 

 Ratio 

o Original 

o 3:2 

o 1:1 

 Fit 

o Fit 

o Fill 

 HBuffer 

 VBuffer 

 Gap 

 Radius 

 Background Color 

 Opacity 

 Layout 

o Rows 



o Columns 

o Adding the number of Rows or Columns in a Collage 

  

Working with DG Foto Smart 

Working with DG Foto Smart is fairly simple. This section and the rest to follow will guide you step by 

step to work with DG Foto Smart and create exclusive template pages. We shall walk you through the 

entire application and make you conversant with the features of DG Foto Smart while creating sample 

template pages.  

It is therefore recommended that you read the topics under this section in a sequence without skipping 

any topic. 

Starting DG Foto Smart 

Let us now get started with using DG Foto Smart 

You can start DG Foto Smart by double-clicking its desktop Icon  

 

  

                                                                



Activation and Registration  

Design Smart can be used only after Registration 

 

1. To use the software, you would require to activate and register the software. 

2. The registration window will appear when you start the software and only if the software is not 

registered 

 

3. Enter all the details. Please note *denotes mandatory field 



 

4. Please select the appropriate Profession by clicking the drop down 

 

5. Enter the Serial Number provided to you and click on the register button 

6. You will receive your login ID and Password along with the Activation Key. 

7. Kindly keep these details for any further communication 

 

  

Home Screen  

When you start DG Foto Smart it will load the Home Screen of the Software. 

 

The Home Screen Consists of the Following 



New Project  

Clicking on this Button will open the New Project Window for creating a new project 

All Projects  

All created projects are seen as thumbnails under this tab. It also shows the count of Number of Project. 

When you move your mouse on the thumbnail, you will see information regarding the Number of Pages 

and Dimension.  

You can also perform the task of 

1. Opening Project: You can open the project by double clicking on the thumbnail. 

2. Delete Project: You can delete a project by selecting the project and clicking on the delete button 

3. Export/Order: You Export/Order a project by clicking on the Export/Order button 

My Exported Orders  

All your Exported/Ordered project will be removed from the All Projects section and will be displayed as 

thumbnails under this Section. This Section also shows the total number of Exported/Ordered Projects. 

Moving the mouse pointer on the thumbnail will display a tooltip containing 

 Number of Pages 

 Dimensions 

 Size of Project 

 Format 

Creating a New Project 

To begin the job of creating pages, you need to create a new project first in DG Foto Smart. Let us have 

a look at the various options and steps involved in creating a New Project. 

  

Opening the New Project Window  



1. To create a new project, click the  New Projects button in the Home Page.   

2. The New Album/Project window is displayed. 

 

  

Defining the Project Name 

 

Replace the default project name in the Project Name text box with a name of your choice. You can 

enter a client's name for your reference. If you choose not to rename the default name, the subsequent 

projects will be automatically named in series. 

 

 Defining the Path for Storing the Project 

 

1.  For defining the path, click the   Browse button in the Project Path.  

2. The Choose a working directory window is displayed.  



 

3. You can also create a new folder for storing the project. 

4. Click the   New Folder button. 

5. Write the name of the new folder and Press Enter 

 

6. Now Select the folder where you want to save the Projects and click on Select folder.  



7. Notice that the newly created folder name appears in the Project Path text box in the New 

Album/Project dialog box. 

 

8. Your project will get saved into this new path. 

  

 Defining the Page Size 

Click the drop-down list in Preset Size to define the page size.  

1. Select an appropriate preset size. 

 

                                 

2. You will also see a preview for the Size selected. Insert SS 

 

Once the Preset size is selected you will also notice different default specifications associated with the 

Preset Size.  



                                

1. Page Display: This will specify if the pages loaded on the canvas are single pages or spreads 

2. Starting Page: The starting page shows whether the first page will start from Left or Right. If the Page is 

starting from Left then the first page will be a Spread i.e. both left and right page. If the Starting Page is 

Right, then the first page will be a Half page of spread i.e. a Single Page 

3. Page Dimensions: The Width and Height text boxes display the dimensions of the selected size 

automatically in the Page Dimensions section along with the Units. It also specifies the number of pages 

and corresponding spreads 

4. Page Safe Area: The Values of Safe Area will be displayed for left right top and bottom 

Along with the Page, DG Foto Smart will also create a Digital Cover Page 



 

Digital Cover Page will have the following Section 

1. Cover Display: You can have a Single Page Cover or Front and Back Cover 

2. Cover Dimension: Default size will be loaded as per the Selection of Preset Size 

3. Cover Safe Area; Default Values will be loaded for Left Right Top and Bottom 

4. Spine Width: Value for Spine Width will be loaded as mentioned for the Preset Size 

If all the values for the selected size are fine, you can click on the Next or Finish Button 

Please Note: You cannot change any values of the preset size unless you click on the Edit button. 

Modifying the values of Preset size is explained in the Subsequent Sections 

The next button will load the Image Upload window and the Finish button will load The Canvas 

  

Keyboard Shortcut Function 

CTRL+N Opens a New Album/Project dialog box 

 

 

Modifying the Preset Size 

If you want to change any values from the Preset Size, you will require to modify the Preset Size. To 

modify the values 

1. Select the Preset Size and Click on the Edit Button. 



2. You will notice that the Values are now editable 

 

Values which can be edited are 

1. Page Display : This will specify if you want a single page or a Spread loaded on 

the canvas  

2. Starting Page : The starting page shows whether the first page after the 

cover will start from Left or Right. If the Page is starting from Left then the first page will be a 



Spread i.e both left and right page. If the Starting Page is Right, then the first page will be a Half 

page of spread i.e a Single Page 

3. Page Dimensions: You can change  

 

 The Width and Height of the Page by clicking on the Arrow Keys provided next to the 

text boxes or by simply typing the size  

 Units: You can Select Inches, Millimeters or Centimeters from the Drop Dow 

 Change the Number of pages. If the Page Display is Page, then the Pages drop down will 

have 1, 2,3 etc. and the Spreads will be 0. If the Page Display is spread, then the drop 

down will have Pages as 2, 4, 6 and its corresponding spreads will automatically 

calculated and displayed 

4. Page Safe Area :  Safe Area 

shows the area on a page that might get cut while binding. You can add Safe Area values for left 

right top and bottom. These values will be displayed on the Page. This Value is included in the 

Size and is not additionally added to the size 

Along with the Page, DG Foto Smart will also create a Digital Cover Page. 

You have the option to have a Cover Page for the Project or not have a cover page at all. This can be 

done by checking or unchecking the Check Box for the Cover Page 



 

Digital Cover Page will have the following Section 

 

1. Cover Display : You can have a Single Page Cover or Front and Back Cover 

2. Cover Dimension : You can change the Width and the 

Height of the Cover Page 

3. Cover Safe Area  : Area which 

might get cut will binding. The values for Left Right Top and Bottom can be mentioned 

4. Spine Width : You can change the Width Value for Spine. 

2. If you want to revert the changes, you can click on the Cancel Button  

3. If you want to replace the Preset Size Values with the New values, you can click on save button 

. 

4. If you do not want to replace the existing size and just want to use the size for this project only, 

simply click on the next or the finish button 



 

Creating New Preset Size 

DG Foto Smart Also allows you to create your own Preset Size which will be displayed in the Drop Down 

list.  

To create a New Preset Size.  

1. Click on the New Button in the User Defined new project Window. You will notice that the 

Values become zero and are now editable  

 

Values which can be added or changed are 

1. Select Page Display : Page or Spread 



 This will specify if you want a single page or a Spread to be loaded on the canvas  

2. Select Starting Page :   Left or Right 

 The starting page shows whether the first page after the cover will start from Left or Right. If 

the Page is starting from Left then the first page will be a Spread i.e both left and right page. 

If the Starting Page is Right, then the first page will be a Half page of spread i.e a Single Page 

3. Enter Page Dimensions: You can add  

 

 Add the Width and Height of the Page by clicking on the Arrow Keys provided next to the text 

boxes or by simply typing the size. You can also swap the sizes by clicking on the  Swap Sizes 

button. You will notice that when the size is a square or a Portrait the Icon will be displayed as a 

portrait. When the size is a landscape size, the icon will also be a landscape.  

5. Select Units : You can Select Inches, Millimeters or Centimeters from the 

Drop Dow 

6. No. of Pages :  You can Change the Number of pages. If the Page Display is 

Page, then the Pages drop down will have 1, 2,3 etc and the Spreads will be 0.  



If the Page Display is spread, then the drop down will have Pages as 2, 4, 6 

and its corresponding spreads will automatically calculated and displayed 

4. Page Safe Area:  

 

 As you change the Page Size, Safe Area Values gets added automatically. You can type in you 

our values. 

 You can add one size in the All Area Size   and it will automatically get added for 

Top, bottom, left and right or You can type these values individually 

 Safe Area shows the area on a page that might get cut while binding. You can add Safe Area 

values for left right top and bottom. These values will be displayed on the Page. This Value is 

included in the Size and is not additionally added to the size 

Along with the Page, DG Foto Smart will also create a Digital Cover Page. 

You have the option to have a Cover Page for the Project or not have a cover page at all. This can be 

done by checking or Unchecking the Check Box of the Cover Page 



 

Digital Cover Page will have the following Section 

1. Cover Display : You can have a Single Page Cover or Front and Back Cover 

2. Cover Dimension : You can 

change the Width and the Height of the Cover Page 

3. Cover Safe Area : Area which 

might get cut will binding. The values for Left Right Top and Bottom can be mentioned 

4. Spine Width : You can change the Width Value for Spine. 

5. If you want to reset the values added, click on the Cancel Button  

6. If you want to Save the New Size, Click on the Save Button. This will load a window to Save 

New Preset 

7. In the Save new Preset Window. Enter the Required Name or you can keep it default 



 

8. Add Description and click on the  Save Button 

9. If you do not want to Add the new size in the Preset Size and just want this to be used size for 

this project only, simply click on the next or the  finish button 

Importing Images 

Once you click on the Next button after selecting the size and its parameters. The next thing you 

would require to do is to Import Images which you want to use for the Project. If you do not want to 

Import Images now, simply click on the Next button 

 

You can Import Images which are stored on your computer or Images which are stored on Cloud or any 

social media. 



 

In DG Foto Smart you can Import Images by Creating a Category and Importing Images Inside a Category 

or Importing Directory or Folder 

 Importing Images by Creating Categories 

Categories can be created to Organize particular set of Images e,g One Category will be Portraits of a 

Couple. Another Category will be Wedding Ceremony of the Same Couple. By this it will be easy for you 

to access particular set of Images at one place. 

 To create Categories   

1. Click the    Category Create category button in the photo gallery.  

2. This will open a Create Category Window 

 

3. Give a Name to the Category and Click on  OK button 

4. The Created Category will be displayed on the left hand side screen, below the create category 

button 



 

Add Images in Categories 

1. Click on the  Import a Files button.  

2. This will open Select files to Import window 



 

3. Browse the Folder where files are saved. 

4. Select all the Images you want to import and Click on Open 



 

5. You will get a progress window.  

 

6. Once the importing is completed all your Images will be displayed as thumbnails under that 

Category 



 

7. You will also see the number of Images that a category 

contains and  

also the Total number of Images in all the Categories  

 

Importing Images Directory 

1. Click on  Import a directory button.  

2. This will open the Select Folder to Import from 



 

 

3. Select the Folder containing the Images and click Select Folder button in the window. 

4. You will see a progress bar.  

 

3. Once the progress is completed you will notice the Imported folder name along with the 

Number of Images  



 

 

DG Foto Smart allows you to create as many categories or import as many folders as you want. It also 

shows you total number of Images in a Category and total number of Images in all the categories 

 

Renaming and Deleting Folders/Categories 

You can Rename or Delete the categories which you have just imported 

   

Renaming categories 

1. Select the Category that needs to be renamed  

 

2. Click the  Edit button button.  

3. Rename Category window will get loaded  



 

4. Type the new name and click on OK 

 

5. The New Name will appear in the Box 

 

  

Deleting Categories 

1. Select the Category  

 

2. Click on the   Delete Category Button 

3. You will receive a confirmation message. Click on Yes to confirm Delete 



 

4. You will see that the category is deleted 

 

Please Note: This will not delete the Images from your Computer 

 Rotating Images  

You can find some Images in the photo gallery having an improper orientation. These Images need to be 

rotated before you proceed to the Next Step. 

1. Select the Category from which the Images need to be rotated  

 

2. Locate the Images which need to be rotated. 

 

3. Select all the Images by pressing the ctrl button and selecting the Images or a single photo  



4. Click on the  Rotate Left or Rotate Right button  

5. Notice the Images will be rotated as per your selection of Rotate Left or Right 

 

Images copied from a CD-ROM have 'Read Only' attribute. Remember to change this status through 

windows properties. Images with a 'Read Only' attribute cannot be rotated. 

  

Deleting Images  

You can delete the unwanted Images from the Category.  

To delete Images 

 

1. Select the Category from which the Images need to be deleted  

 

2. Locate the photo which you want to delete 

3. Select all the Images by pressing the ctrl button and selecting the Images or a single photo  



 

4. Click on the  Delete button  

5. You will be prompted to confirm the deletion, through the following dialog box. 

 

  

6. Click   Yes if you wish to delete the photo(s). 

7. The selected photo(s) gets instantly deleted. 

 

8. After you have imported all the Images, click on the  Next Button 

Designing Options 

After Importing Images, the next step is to choose the Design Options. 



 

DG Foto Smart provides you the facility to create Auto Album with different Styles or Create Design 

Pages Manually  

Auto Album Creation 

DG Foto Smart has provided 2 Options to Create Albums Automatically viz Classic Mode and Designer 

Mode 



Create Auto Album with Classic Mode 

 

In this Mode you can create Auto Albums using Collages. In this Mode no Images get cut. You can also 

specify the Number of Images you want in a Single Page 

For creation 

1. Double click on the Classic Mode 

2. It will load the Theme Window 

 



3. Specify the Number of Images Per Page  

4. Select the Category.  

 

5. Themes will be loaded as per the Category Selected. Select the Theme.  

 

6. You can also see the preview of the theme by clicking on the  Preview button on the 

theme 

 

7. A Preview will be generated and you will see a Theme Preview Window 



 

8. You can play the preview by clicking on the  Play button 

9. You can also navigate through the pages by clicking the  Next or the  Previous 

button 

10. If you like the Theme you can click on  Apply and your Album will get created on the 

Canvas 

11. If you want to change the theme, close the preview by clicking on  cancel and 

select a different theme and click on the finish button 

12. Your Project with the selected theme gets created on the Canvas 

 



 

Create Auto Album with Designer Mode 

 

In this Mode you can create Auto Albums using predesigned templates or themes.  

For creation 

1. Double click on the Designer Mode 

2. It will load the Theme Window 



 

3. Select the Category.  

 

4. Themes will be loaded as per the Category Selected. Select the Theme.  

 

5. You can also see the preview of the theme by clicking on the  Preview button on the theme 



 

6. A Preview will be generated and you will see a Theme Preview Window 

 

7. You can play the preview by clicking on the  Play button 

8. You can also navigate through the pages by clicking the  Next or the  Previous 

button 

9. If you like the Theme you can click on  Apply and your Album will get created on the 

Canvas 

10. If you want to change the theme, close the preview by clicking on  cancel and select a 

different theme and click on the finish button 

11. Your Project with the selected theme gets created on the Canvas 

 



Manual Album Creation 

Create Album Pages with Manual Mode 

 

In this Mode you can create your own page design using Pre designed templates or themes, 

Backgrounds, Cliparts, Borders, Masks and many other designing options  

For creation 

1. Double click on the Manual Mode 

2. It will load blank pages on Canvas 



 

 

Loading Templates in the work area 

 

DG Foto Smart comes bundled with huge library of ready to use templates. You can choose a template 

of any size and directly use it in your projects. While doing so the selected template page gets 

automatically resized to fit itself in the project page without affecting the look and feel.   

Let us see how to use these templates.  

Loading Template on a Blank Page 

1. Load the blank page on the canvas. 



 

2. Click on the   Template Gallery Button 

3. The Template Gallery gets loaded 

 

 

4. Select either the Stock tab which contains all the templates provided with the Software or the 

User tab which will contain the templates that you would be designing and saving 

 

5. Select the Category   and Sub Category  from the Drop Downs under Stock or User 

6. It will display various categories of templates in the Drop Down List 



  

7. Templates are based on number of Images per Page, Select the Desired Category of Template 

and then select the number of Images that you wish to insert on  Page or select All from the Sub 

Category to display all the templates 

 

8. All the Templates from the Selected category will be displayed as thumbnails 

9. Double click  on the thumbnail you like   

10. The selected template gets instantly loaded in the work area with all the default material and 

properties used in it.  



 

 

11. The simplest form of a template page will look like this. It comprises of template Images marked 

with numbers 1,2,3,.. depending on the number of Images on the template.  

 

 



 Replacing Template on a Page 

You can also replace a page which has template with a new template 

1. Consider the following Template Page loaded 

 

2. Click on the  Template Gallery Button to load the template gallery 

 

3. Select either the  Stock tab which contains all the templates provided with the 

Software or the  User tab which will contain the templates that you have designed 

and saved 

4. Select the Category from the Drop Downs under Stock or User 

 



5. Select the Sub Category from the Drop Downs under Stock or User. Templates are based on 

number of Images per Page 

 

6. I All the Templates from the Selected category will be displayed as thumbnails  

 

7. Double click  on the thumbnail you like   

 

8. The selected template gets instantly loaded in the work area replacing the old template with all 

the default material and properties used in it.  



 

9. If the New Template has less number of Images compared to the Existing Page, then the extra 

Images will get removed 

 

10. If the New Template has more number of Images compared to the Existing Page, then the place 

holders for the Images will be blank having numbers on it   



 

 

 

Importing Material/Folders in Galleries 

In order to add additional Images or if you want to Import any other objects like Borders, Masks, Clipart, 

Texture into your projects, you need to fetch them from some source like the hard disk or any other 

media. Hence you need to tell the application where these objects are. This process is called Importing.  

Let us see how to Import Material/folders for Images or any other Objects in DG Foto Smart. 

In DG Foto Smart you can Import Images by Creating a Category and Importing Images Inside a Category 

or Importing Directory or Folder 

 

 

Importing Images by Creating Categories 

Categories can be created to Organize particular set of Images e,g One Category will be Portraits of a 

Couple. Another Category will be Wedding Ceremony of the Same Couple. By this it will be easy for you 

to access particular set of Images at one place. 

 To create Categories   

1. Click the  Photo button. This will load the photo gallery 



2. Click the  Category Create category button in the photo gallery.  

3. This will open a Create Category Window 

 

4. Give a Name to the Category and Click on OK 

 

5. The Created Category will be displayed in the Drop Down list under User Tab  

 

Add Images in Categories 

1. Click on the  Import a File button.  

2. This will open Select files to Import window 



 

3. Browse the Folder where files are saved. 

4. Select all the Images you want to import and Click on Open 



 

5. You will get a progress window.  

 

6. Once the importing is completed all your Images will be displayed under that Category 

 



 

Importing Images/Objects Directory 

1. Click on  Import a directory button in the Gallery Window 

2. This will open the Select Folder to Import from 

 

3. Select the Folder containing the Images and click  Select Folder button in the 

window. 

4. You will see a progress bar.  



 

4. Once the progress is completed you will notice the Imported folder name displayed in the drop 

down. 

 

5. Once you select the folder from the drop down, you will see all the Images inside the folder 

displayed as thumbnail in the Images Gallery 

 

 

DG Foto Smart allows you to create as many categories or import as many folders as you 

want 

 

Renaming and Deleting Folders/Categories 

You can Rename or Delete the categories which you have mapped for use in DG Foto Smart.  

   

Renaming categories 

1. In the Gallery Window, Select the Category that needs to be renamed from the drop down list 



 

2. This will display the name of the Category in the Tab 

 

3. Click the  Edit button below the drop down list.  

4. Rename Category window will get loaded  

 

5. Type the new name and click on OK 

 

6. The New Name will appear in the Box 

 

  

Deleting Categories 

1. In the Gallery window, Select the Category that needs to be Deleted from the drop down list 



 

2. The Images of the selected category gets loaded in the Gallery 

 

 

3. Click the  Delete button below the drop down list.  

3. A Confirmation dialog box is displayed. 

  

4. Click  yes, if you wish to delete the category. 

5. The Folder is instantly deleted. 

 

6. DG Foto Smart will not allow deleting Categories/Folders if the Images inside the Categories are 

used in the current album. It will display the following message 

 

Remember that deleting a category will not physically delete the corresponding folder from the hard 

disk. 



 

 

Rotating Images in Gallery 

You can find some Images in the photo gallery having an improper orientation. These Images need to be 

rotated before pasting it on the template pages. 

 

1. Click on the  Images button to load the Images in the gallery. 

2. Select the Category from the drop down from which the Images need to be rotated 

 

3. Locate the Images which need to be rotated. 

 

4. Select the Photo  

 

5. Click on the  Rotate Selection button  

4. A Sub Menu appears. 

 



5. Select the rotation direction as  Rotate Left(-90) or  

Rotate Right (90) in the menu. 

 

 

6. The selected photo in the gallery gets instantly rotated. 

 

 

Please Note:  

You can also select multiple Images and rotate them together in the Gallery 

Images copied from a CD-ROM have 'Read Only' attribute. Remember to change this status through 

windows properties. Images with a 'Read Only' attribute cannot be rotated. 

  

Deleting Images in Gallery 

You can delete the unwanted Images in the gallery. If the photo is already used in the project, you will 

be prompted accordingly. 

Let us learn how to delete a photo in the gallery.   

 

1. Click on the  Images button to load the Images in the gallery. 

2. Select the Category from the drop down from which the photo need to be deleted 



 

3. Locate the photo in the gallery which you want to delete. 

 

4. Select the Photo  

 

5. Click on the  Delete button or Right Click on the photo and Select Delete from the 

options(Insert SS) 

6. You will be prompted to confirm the deletion, through the following dialog box. 

 

  

7. Click   Yes button if you wish to delete the photo from the gallery. 

8. The selected photo in the gallery gets instantly deleted. 

 

 



9. If the photo you wish to delete has been already used in the project, you will get the following 

message 

 

 

 Remember that deleting Images from the gallery will not permanently delete them from the Hard 

Disk.  

  

View Option(Thumbnail View Options) 

DG Foto Smart provides you option to view photo thumbnails with Name or Tooltip with Photo Info in 

the Gallery window. You also have the option to select both 

View with File Name 

By selecting this option, the thumbnails of Images in the Gallery will be displayed with their name below. 

1. Click on the  Images button to load the Images in the gallery. 

 

2. Click on the  View Option in the Photo Gallery 

3. It will load the Library View Settings box 

 

4. Select the View with File Name check box 



 

5. Close the Library View Settings 

6. You will see that the images will display the File Name below it. 

 

View Tooltip with Photo Info 

By Selecting this option, there will be a tooltip displayed when you move the mouse cursor on the 

photo. The tooltip will have Photo Name and its dimension Mentioned. To select this option 

1. Click on the  Images button to load the Images in the gallery. 

 

2. Click on the  View Option in the Photo Gallery 

3. It will load the Library View Settings box 

 

4. Select the Tooltip with Photo Info check box 



 

5. Close the Library View Settings 

6. You will see that the when you move the mouse on the photo a tool tip with name and 

dimension will appear 

 

 You also have the option to select both  

 

 

 This will display the Filename and the tooltip will also be seen when you move your mouse 

pointer on the Thumbnail 

 

 

 

 

 



Rearranging Gallery Elements 

You can sort thumbnails in the Gallery window using the various options provided in DG Foto Smart  

To Sort Images 

1. Click on the  Images button to load the Images in the gallery. 

 

2. Click on the  Sort Options button.  

3. You can choose the sorting option. You can sort Images by 

 

 

 Sort By Name: This will sort the Images by Name in Ascending or descending order 

 

 Sort By Size: This will sort the Images by Size in Ascending or descending order  

 



 Sort By Orientation: This will sort the Images by Orientation i.e Portrait or Landscape 

 

 Sort By Time: This will sort the Images by time in Ascending or descending order  

 

 Sort By Used: This will sort the Images by Used/Unused order  

 

Thumbnail Size 

You can change the viewing size of Thumbnails in Galleria.  

To change the Thumbnail Size 

1. Click on the  Images button to load the Images in the gallery. 

 

2. Select Small or Big radio button  



3. Notice the thumbnail size changes as per your selection 

Small Thumbnail View  

 

 Big Thumbnail View   

  

 

 

Pasting Images on the Templates 

You can paste Images from the Gallery onto the template pages in the following ways: 

  

 Pasting Images Automatically 

 Pasting Images Manually 

 Pasting Images by Drag and Drop 

 Pasting Multiple Images at a Time 

 Adding Extra Photo on the Template Page 

 Replacing Images 

  

It is important to note that if there are special properties assigned to the template Images, they get 

assigned to the pasted Images as well. 

mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Pasting_Photos_Automatically.htm
mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Pasting_Photos_Manually.htm
mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Pasting_Photos_with_Drag_and_Drop_Method.htm
mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Pasting_multiple_photos_at_a_time.htm
mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Adding_Extra_Photo_on_the_template_page.htm
mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Replacing_Photos.htm


 Pasting Images Automatically 

  

1. Consider the following template page.(Insert Blank Template Page) 

 

2. Click on Images to load the Images Gallery and Select a photo from the gallery 

 

3. Double Click the photo.  

 

4. The selected photo is pasted on the template photo marked as 1. The pasted photo gets 

automatically cropped to accommodate itself in the frame. If the template photo has some 

properties assigned to it like Masks, Filters, Tones etc., these will also be applied on the pasted 

photo automatically. 



 

5. Also notice that after pasting, the template photo which was marked as 2 earlier, gets assigned 

as 1 and every new photo that you add from the gallery, always gets attached on the photo 

marked as 1. Automatically the Photo 1 gets selected. Once the selected photo is pasted on the 

template photo, its label is assigned to the next template photo in the template.  

 



 

6. Notice that while pasting a Gallery photo into the template, it will show the count of the photo 

used in a project. This is a unique feature to differentiate the used Images with the un-used in 

the current project. 

 

 

6. You can use this method to quickly paste Images on the templates in a sequence. 

 Remember that while pasting Images automatically, ensure that no template photo is selected. 

 

 

 



 

 Pasting Images Manually 

The method of pasting Images manually is used for pasting Images at an exact position of a desired 

template photo. 

  

 

1. Consider the following Template Page 

 

2. Click on particular template photo on which you wish to paste a photo from the Gallery.  



 

3. Now double-click a photo in the Gallery for pasting it on to the selected template photo. 

 

 

4. The photo from the Gallery gets pasted instantly on the selected template photo. The pasted 

photo gets automatically cropped to accommodate itself in the frame. If the template photo has 

some properties assigned to it like Masks, Filters, Tones etc. these will also be applied on the 

pasted photo automatically. 



 

 

5. The advantage of this method is that you can paste the Images at the desired location to suit the 

orientation of the photo to be pasted. 

Pasting Images with Drag and Drop Method 

The method of pasting Images by drag and drop method is used for pasting Images on a desired 

template photo. 

   

1. Consider the following Template Page 



 

2. Drag a photo from the gallery with the left click of the mouse. 

 

3. Keeping the mouse key pressed; take the mouse cursor over the Number of the template photo 

you wish to paste on. At this point the template photo gets marked with a green outline. 

 



 

4. Now, release the mouse button 

5. The selected photo gets instantly pasted on the template. 

 

 

6. This is the fastest and easiest method for pasting the gallery Images any time anywhere.  

  

Remember that if you release the mouse button while the outline is not green, the selected photo gets 

added as an additional photo on the template. 

 

Adding Extra Photo on the template page (At Center) 

This method is used for adding extra Images on a template page. 

1. For using this method, make sure that no template photo is selected and all the template 

Images are replaced with Images from the Gallery. If at all any photo is selected, unselect it by 

clicking outside the page area. 

2. Consider the following Template Page 



 

2. Double click on a photo in the gallery  

 

3. The selected photo always gets pasted at the center of the page, by default.  

 

4. The photo will also display the number of times the photo has been used in the Photo Gallery 



 

5. DG Foto Smart allows you to paste as many Images as you wish with this method. 

 

Replacing Images 

  

This method is used for replacing an already pasted photo with a new one at any point of time. 

1. Consider the following template page 

 

2. Click on the template photo to be replaced.  



 

3. Double-click on a photo in the gallery  

 

4. The selected photo gets instantly replaced with the gallery photo and contains all the properties 

of the earlier photo. 

 

5. You can also use the drag and drop method for replacing the Images.  



6. You will also notice the change in the count on the photo  used in the Photo Gallery 

 

It is important to note that if there are special properties assigned to the template Images, they get 

assigned to the pasted Images as well. 

  

Resizing Images in Templates 

This method is used for resizing a single photo or multiple Images on the template page to any size as 

per your choice. 

Resizing by Scaling 

Resizing Single Photo 

1. Consider the following Template Page 

 

2. Click on the photo on the template page which needs to be resized. 



 

3. Now move the mouse on any of the four corners until you see a  double-headed arrow.  

4. Click this node with the mouse and drag inward or outward to resize.  

 

5. You will also see a reference of the size as a tool tip while resizing the photo 



 

6. Release the mouse button as soon as the desired size is obtained. 

 

7. Remember that in DG Foto Smart, the photo always gets resized proportionately when scaled 

from the corners.  

 

 

 



Resizing Multiple Images 

You can also resize multiple Images at one time 

1. Consider the following Template Page 

 

2. Select the multiple Images on the template page which needs to be resized by using the CTRL 

Key. 

 

3. You will see a Blue Color selection around the Edges and the Center of the Images. This is called 

Grouping. 



 

 

4. Now move the mouse on any of the four corners until you see a   double-headed arrow.  

 

5. Click this node with the mouse and drag inward or outward to resize.  



 

6. Release the mouse button as soon as the desired size is obtained. 

7. The photo gets proportionately resized instantly. 

 

 

 

  



Parametric Resizing 

 If you want to resize a single or multiple Images to a specific size you can use the parametric resizing 

Resizing Single Photo 

1. Consider the Following Template Page 

 

2. Select the photo for resizing with specific dimensions 

 



3. Click on the Edit  Button in the Effects window to load the Edit Options 

 

4. Notice that the Width and Height text boxes display the current dimensions of the selected 

photo. 

 

5. Enter the new dimensions of the photo into the width and height text boxes. And Click on Apply 

 

6. You also have the option to change the Unit 

 



7. The Photo will get resized instantly 

 

8.  If you want the value of the height proportionally changes with respect to the width and vice 

versa then click on the  Constraint Proportions icon, notice the button changes to  lock 

icon 

9. Type the width in the text box and notice the height changes automatically 

 

10. The photo crops to fit itself into the new dimensions without losing its aspect ratio. 



 

Resizing Multiple Images 

1. Consider the following template page 

 

2. Select the multiple Images on the template page which needs to be resized by using the CTRL 

Key. 



 

3. You will see a Blue Color selection around the Edges and the Center of the Images. This is called 

Grouping. 

4. Click on the  Edit Button in the Effects window to load the Edit window 



 

5. Notice that the Width and Height text box displays the current dimensions of the selected 

Images. 

 

6. Enter the new dimensions of the Images into the width and height text boxes. And Click on 

Apply 

 

7. You also have the option to change the Unit 

 



8. The Images will get resized instantly 

 

9. If you want the value of the height to proportionally change with respect to the width and vice 

versa then click on the  Constraint Proportions icon, notice the button changes to  lock 

icon 

 

10. The Images crop to fits itself into the new dimensions without losing its look and feel. 



 

Resizing Objects with respect to Other Objects  

DG Foto Smart provides instant resizing tools to proportionately resize multiple objects and make them 

of the same width or height as the last object selected. 

 

1. Ensure that you have at least two objects on the template page in order to use this option. 

2. Consider the following template page.  

 



3. Keeping the CTRL key pressed, click to select the Objects, one by one, in order to resize them 

with respect to the last selected object. 

 

4. The last selected photo will have a yellow outline 

 

5. Let us now use the various options for resizing objects with respect to other objects. 

6. Click on the  Edit Button in the Effects Window to load the Edit window 



 

7. There will be various options for resizing under Match Size 

 

8. Select the   Same Width option to resize with respect to size 



 

9. The selected objects get resized proportionally with respect to the Width of the last selected 

object. 

10. Similarly you can resize the Images with respect to Height by clicking on the  Same Height 

option 

 

11. Similarly you can resize a photo with respect to the last photo selected and use the  'Same 

Width & Height' option. 



 

12. Notice that the photo automatically gets cropped from the center if required. 

13. Remember that using the Resizing option will not change the actual dimensions of the original 

object. 

  

Repositioning Images on Template Pages 

This method is used for repositioning/moving a photo anywhere on the template page as per your 

choice.  

 

1. Consider the following template page 



 

2. Select the photo(s) on the template which needs to be repositioned. 

 
  

3. Keeping the left mouse button pressed, drag the photo(s) over the template page. 

4. You can also check the position of the photo in the  Position 

Window which is available in the  Edit Window of Effects Gallery. As you move the object 



the selected objects, the current position of the photo(s) is displayed in the Position Information 

Box. 

5. Release the mouse button at the new position of the photo. 

 

For moving the Images or other objects in exactly vertical or exactly horizontal direction, keep the 

SHIFT key pressed and move the object towards the Up or Down.  

Grouping Ungrouping 

DG Foto Smart provides you with the Option to move multiple Images together. This feature is called 

grouping 

1. Consider the following Template page 



 

2. Select all the Images by pressing CTRL+ A or selective Images CTRL+ clicking on the selected 

Images 

 

3. Notice that there will be a blue color outline with all the selected Images inside it 



 

4. Now click on the  white box which will be at the center of the selection 

5. The mouse icon will change to a  move icon 

6. Keeping the mouse pressed move the Images where you want and release the mouse on 

reaching the desired position 

 

7. To ungroup, click anywhere on the canvas 



 

Zoom Photo 

DG Foto Smart provides onboard Zooming feature. With this feature, the photo can be zoomed in or 

zoomed out keeping the original size of the Photo on the template page. 

1. Consider the following Page 

 

2. Select the photo which you want to zoom 



 

3. Click on the Zoom button Insert Icon. 

4. Keeping the zoom tool pressed, move the mouse pointer upwards or downwards. Notice the 

color of the Zoom Icon changes to Orange 

 

5. The extra portion of the photo can also be seen outside for reference 



 

6. You will see that the photo gets zoomed in or out based on the mouse movement instantly. 

 

 

Panning Photo 

DG Foto Smart provides onboard Panning Feature. With this feature you can adjust the photo are 

without compromising the size 

1. Consider the following Page 



 

2. Select the Photo which you want to adjust 

 

3. Click on the Pan Tool. 

4. Keeping the Pan Tool Pressed moved the Photo inside the Template Photo as per you 

requirement. Notice the color of the Pan tool changes to Orange 



 

5. You will also see the additional photo which is outside the Photo View area for reference 

 

6. Release the Pan Tool once the you feel that the photo is adjusted as per your requirement 



 

 

Cropping 

Cropping Images 

The onboard Crop tool allows you to remove unwanted area of the photo by compromising the original 

composition and creating your own. 

Cropping by Compromising Template Composition 

With this method, you can crop the photo as per your selection. In this method, the original template 

composition changes as per the crop area selected. 

 

1. Consider the following template page. 



 

2. Click on a Photo to be cropped. 

 

3. Click the   center handlers on the Photo. 

4. If the Photo needs to be cropped from the top or bottom, click and drag the top or bottom 

handles 



 

5. If the Photo needs to be cropped from the left or right, click and drag the left or right handles 

 

6. The will also show the area that is being cropped 



 

7. If the photo has a border or mask applied on the photo, it will get adjusted as per the photo 

automatically 

 

   

Cropping will not alter the original Images. 



Cropping Photo using Shapes  

DG Foto Smart allows you to apply a shape to the Photo. You can apply a Rectangle, Rounded Rectangle 

and an Ellipse Shape to a Photo 

To apply a shape on the Photo 

1. Consider the following page. 

 

2. Select a Photo on which you want to add a Shape 

 



3. Click on the  Edit Button in the Effects Window 

4. It will load the Edit Panel 

 

5. Select the Shape that you want to add on the Photo from the Crop Shapes 

 

6. You can choose from  Rectangle, Rounded Rectangle and Ellipse Shape 

7. The Shape Gets instantly applied on the Photo 



 

8. To apply a rounded rectangle shape. Select the Photo 

 

9. Click on the Rounded rectangle Icon 

 



10. It gets applied instantly on the Photo 

 

11. You can also change the Radius of the shape. This is applicable only in case of Rounded 

Rectangle and Ellipse Shape. 

 

12. To change the Radius, drag the slider under Radius or type the value in the text box. Notice the 

Edges of the photo changes instantly. 

 

13. Notice the changes applied on the Photo. 



 

14. To reset the Shape, click on the  Reset Button next to the text box. 

 

Quality Indicator on Objects 

A very important feature provided in DG Foto Smart which indicates whether the Photo is suitable for 

the desired output size once the photo is placed into the Project Page 

How the photo Quality indicators work? 

As soon as you add any photo on the canvas and if the quality of the photo is not proper or just about 

adequate for printing, a quality indication will be displayed on the photo. The representation of the 

Indicators are mentioned below 



 

  

Following are the Photo Quality indicator along with their meanings.                     

  

Color Remark Description 

No 

Indicator 

Perfect Quality The Quality of the Photo is Perfect for Prinnting 

Yellow 

 

Satisfactory Quality The quality does not meet requirements totally; however 

you will have satisfactory result. 

Orange 

 

Adequate Quality There will be visible quality losses in the finished product. 

Red 

 

Unsuitable The photo is not suitable for the required format 

  

 



Safe Area Indicator 

If a photo is on the Safe Area, DG Foto Smart provides a red color Indication which means that the Photo 

might get cut during the process of Binding 

You can either move the Photo inside the Safe Area or keep it the same if you’re sure that it won’t be a 

problem even if it is on the safe area 

1. Consider the following template page where the photo is normally placed on canvas 

 

2. Notice the color of the safe area changes when you move the photo on it 

 



 

Rotating Images  

DG Foto Smart Provides you option to rotate a photo using the onboard rotation feature and also from 

the Edit Window in the Effects Window section 

DG Foto Smart also provides rotation of Images inside a frame or mask keeping the Frame or a Mask 

intact in its position 

Rotating a photo   

1. Consider the following template page 

 

2. Click on the photo on the template which needs to be rotated. 



 

3. Click on the Rotation Icon(Insert Icon) which will appear on top of the photo 

 

4. Keeping the mouse key pressed; start dragging the mouse until you get the desired angle of 

rotation. The angle of rotation is also displayed as a tooltip on the photo. 



 

5. Release the mouse as soon as the desired rotation angle is reached. 

 

6. You can also Rotate the Photo from the Edit Panel in the Effects window 

7. Select the Photo  



 

8. Click on the  Edit Button from the Effects widow 

9. You will see a Slider under Rotate. 



 

10. Move the Slider as per your requirement 

 

11. You will also see the angle of rotation. 

 

12. You can also type the value of Rotation in the text box  where the angle of rotation 

is displayed to get a desired rotation of the Photo 



13. If you want to bring the Photo in upright position or want to reset the Rotation. Click on the 

reset  button displayed next to the angle of rotation text box  

  

Rotating a photo inside a Frame or a Mask 

1. Consider the following Page 

 

2. Click on the photo on the template which needs to be rotated. 

 



3. Click on the Inside Rotation Icon(Insert Icon) which will appear on the photo 

 

4. Keeping the mouse key pressed; start dragging the mouse until you get the desired angle of 

rotation. The angle of rotation is also displayed as a tooltip on the photo. 

 

5. Release the mouse as soon as the desired rotation angle is reached. 

6. Notice that the Frame, Mask, Outline or any other object applied on the Photo does not rotate 

as per the rotation. 



 

7. This feature is also called as Cropping by Rotation 

 

Applying Clipart 

DG Foto Smart comes bundled with various Clipart for decorating your template pages. These Clipart 

are organized in various different categories for finding them easily.  

Default Material is listed under Stock Tab under different Categories. The Material Imported 

by you will be listed under User Tab   

Load the Clipart in the Gallery by pressing the   Clipart button.  

  

1. Consider the following template page. 



 

2. Click the  Clipart button to load the library of Clipart in the Gallery. 

 

3. Select the appropriate category from the drop down. 

 

4. Drag a Clipart thumbnail from the library and drop it on the template page. Alternately you can 

also add the Clipart by simply double clicking on it.  



 

5. The Clipart instantly gets added on to the template page. 

6. Click the Clipart on the template page and move it by keeping the mouse button pressed. 

 

7. Release the mouse button when the Clipart is moved to the desired position on the template 

page. 



 

8. Drag any of the corner nodes around the Clipart to resize it on the template page. 

 

9. Release the mouse button when the desired size is reached. 



 

10. Click on any area outside the page to unselect the Clipart. 

 

 

11. You can delete the Clipart by clicking it and pressing the DEL key on the keyboard. 

12. Remember that you can also use other images with alpha channel or 32 bit as a Clipart of you 

own in DG Foto Smart. 

  



  

All the Edit Photo options like Rotate, Color Balance, Effects, Filter are applicable for Cliparts too. 

  

Applying Masks 

DG Foto Smart comes bundled with various Masks for applying on the Images. These Masks are 

organized in various different categories for finding them easily.  

Default Material is listed under Stock Tab under different Categories. The Material Imported 

by you will be listed under User Tab   

 

Let us see how to add masks to the Images on the template page. 

 

1. Consider the following template page. 

 

 

2. Click on a photo or multiple Images on the template to select it. 



 

3. Now click the   Mask button to load a library of masks in the Gallery. 

4. Select the appropriate category from the drop down. 

 

5. All the Mask related to that category will be loaded in the Gallery 

 

6. Drag a mask and drop it over the photo. Alternately you can add a Mask on a selected photo by 

simply double clicking on the Mask in the gallery 



 

 

7. The mask gets applied on the selected photo instantly. 

 

8. To apply the Mask on Multiple Photo simply select the photo and double click on the Masks. 

Drag and Drop of mask will apply the mask only on one photo and not all the Images 

9. To remove the Mask, Select the Photo(s) and Click the  Mask button displayed on the 

content toolbar below the selected Photo  

10. It will display a sub menu. 

 

11. Click on the Remove  Mask button 

12. Notice that the Mask gets removed instantly 



 

 

  

 Mask icon and its submenu will be displayed and enabled only when an alpha shape is applied 

to a photo. 

 

Applying Borders/Frames 

DG Foto Smart comes bundled with various Frames for applying on the Images. These Frames are 

organized in various different categories for finding them easily.  

Default Material is listed under Stock Tab under different Categories. The Material Imported 

by you will be listed under User Tab   

Let us see how to add Borders or Frames to the Images on the template page. 

 

1. Consider the following template page. 



 

 

2. Click on a photo on the template to select it. 

 

3. Now click the  Frames button to load a library of borders in the Gallery. 



 

4. Select the appropriate category from the drop down. 

 

5. Drag a Frame and drop it over the photo. Alternately you can add a Frame on a selected photo 

by simply double clicking on the Mask in the gallery 

6. The mask gets applied on the selected photo instantly. 

 

7. To apply the Frame on Multiple Photo simply double click on the Frame. Drag and Drop of Frame 

will apply the Frame only on one photo and not all the Images 

 

8. To remove the Frame, Select the Photo(s) and Click the  Frame button displayed on the 

content toolbar below the selected Photo  



 

9. Sub menu will be loaded 

 

 

10. Click on the  Remove Frame  button 

11. Notice that the frame will be removed instantly 



 

 Frame icon and its submenu will be displayed and  enabled only when an Frame is  applied to 

a photo. 

Applying Blur and Sharpness 

The tools for applying the Blur and Sharpness are available in the Effects Window, in the Filters Tab. You 

can apply Blur and Sharpness effect on the photo instantly. 

 

1. Consider the following Page 

 



2. Click a Photo to select it. 

 

3. Now click the  Filters Button from in the Effects Window to load the Filter options in the 

Filter Window 



 

4. Drag the   Blur/Sharpen slider towards the right to Blur/Sharpen the Photo. 

 

5. The photo gets blurred/Sharpen instantly on releasing the mouse button. 



 

6. You can also type in a value in the text box to blur or sharpen the Photo/Object 

 

7. Also notice that the slider color changes to Orange.  

 

8. You can click the   Reset button to undo the changes made to the photo. 

DG Foto Smart also provides a huge library of Presets for Sharpen. 

1. Consider the following Page 



 

2. Select the Photo/object 

 

3. In the Filters window, click on the Preset drop down menu 



 

4. Select Sharpness from the Drop drown 

 

5. All the Presets for Sharpness will be loaded 



 

6. You also have the option to sort the preset by Name and Used 

 

7. Double Click on the Preset 

8. The preset gets applied instantly 



 

9. You can also see the value of the preset in the Sharpness text box. 

 

10. You will also see an Orange Outline around the Preset that is used on the photo 

Applying Opacity 

The tools for applying the Opacity are available in the Effects Window, in the Filters Tab. You can apply 

Opacity effect on the photo or any Object instantly. 

  

1. Consider the following template page 



 

2. Click a Photo or the Object to select it. 

3. Now click the  Filters Button from in the Effects Window to load the Filter options in the 

Filter Window. 



 

4. Drag the Opacity slider towards the left to make the photo/object more transparent.  

 

5. The photo becomes transparent instantly on releasing the mouse button. 



 

6. You can also type in a value in the  text box to reduce the opacity of the Photo/Object 

7. Also notice that the slider color changes to Orange.  

 

8. You can click the   Reset button to undo the changes made to the photo. 

DG Foto Smart also provides a huge library of Presets for Opacity. 

1. Consider the following template page 



 

2. Click a Photo or the Object to select it. 

3. Now click the  Filters Button from in the Effects Window to load the Filter options in the 

Filter Window. 



 

4. The Opacity filter will be selected by default, if not then select it from the dropdown list 

 

5. You also have the option to sort the preset by Name and Used 

 

6. Double Click on any  Preset 



7. The preset gets applied instantly 

 

8. You will also see an Orange Outline around the Preset that is used on the photo 

 

9. You will also see the changes and the value in the Opacity Slider 

 



 

Using the Blend Mode  

The Blend mode provided in the software offers the functionality to blend the Object with the 

Background 

Blend Mode can be used with Outline and Filters 

1. Consider the following Template Page 

 

2. Select the photo on which you want to use the blend mode 



 

3. Click on the  Filters button on the Effects Panel to load the Filters window 



 

4. You will notice the Blend Mode is selected as normal by default 

 

5. Select the Blend Mode from the drop down 

 

6. We have selected the Overlay in this case 



 

7. The mode gets instantly applied on the Photo 

 

8. Similarly you can use the Multiply and Screen Mode 

Please note: Blend mode can also be applied to Outline 

 

Brightness, Contrast Hue and Saturation Settings 

Let us see how we can adjust the Brightness, Contrast, Hue and Saturation settings on a photo/object. 

  

The Brightness, Contrast, Hue and Saturation controls are available by selecting the photo and clicking 

the Adjust button in the Effects Window. 

  

Brightness Control 

1. Consider the following Template Page 



 

2. Select the photo/object in the work area (template page) by clicking it once. 

 

3. Click the   Adjust button to load the options in the gallery. 



 

4. Now drag the   Brightness slider either to the left or to the 

right to change the value of brightness. Alternately, 

5. You can enter values into the text box  and press ENTER. 

6. The changes to the photo/object are immediately applied. 

  



 

 

 

 

 

 

Less  Bright   Original  More Bright 

  

Similarly you can also use Presets for Brightness which are provided in DG Foto Smart 

1. Consider the following Template Page 

 

2. Select the photo/object in the work area (template page) by clicking it once. 



 

3. Click the   Adjust button to load the options in the gallery. 



 

4. Click the Preset dropdown and select Brightness from the List 

 

5. All the Presets for Brightness will be loaded 



 

6. Move the Mouse over any preset to see the brightness value of the preset 

 

7. Double click on the preset. The applied preset gets highlighted with an Orange Outline 



 

8. The preset gets instantly applied on the Photo 

 

9. You can also check the value of the Preset on the Brightness Slider 

 

 

Contrast Control 

1. Consider the following Template Page 



 

2. Select the photo/object in the work area (template page) by clicking it once. 

 

3. Click the   Adjust button to load the options in the gallery 

4. Now drag the  Contrast slider to change the value of Contrast.  

5. Alternately, you can enter values into the text box  and press ENTER. 



6. The changes to the photo/object are immediately applied.  

  

 

 

 

 

 

 

Less  Contrast Original  More  Contrast 

  

Similarly you can also use Presets for Brightness which are provided in DG Foto Smart 

1. Consider the following Template Page 

 



2. Select the photo/object in the work area (template page) by clicking it once. 

 

3. Click the   Adjust button to load the options in the gallery. 



 

4. Click the Preset dropdown and select Contrast from the List 

 

5. All the Presets for Contrast will be loaded 



 

6. Move the Mouse over any preset to see the brightness value of the preset 

 

7. Double click on the preset. The applied preset gets highlighted with an Orange Outline 



 

8. The preset gets instantly applied on the Photo 

 

9. You can also check the value of the Preset on the Contrast Slider 

 

Hue Control 

1. Consider the following Template Page 



 

2. Select the photo/object in the work area (template page) by clicking it once. 

 

3. Click the   Adjust button to load the options in the gallery. 



 

4. Now drag the   Hue slider to change the value.  

5. Alternately, you can enter values into the text box  and press ENTER. 

6. The changes to the photo/object are immediately applied. 



 

7. Also notice the Slider Color changes to Orange 

 

    

Saturation Control 

1. Consider the following Template Page 

 

2. Select the photo/object in the work area (template page) by clicking it once. 



 

3. Click the   Adjust button to load the options in the gallery. 



. 

4. Now drag the   Saturation slider to change the value.  

5. Alternately, you can enter values into the text box  and press ENTER. 

6. The changes to the photo/object are immediately applied. 

  



 

 

 

 

 

 

Less  Saturation   Original  More  Saturation 

   

 

Remember that you can also Reset the changes made to the photo/object by clicking on the  reset 

button next to the text box. 

Performing Color Balancing 

 The Color Balance Section of DG Foto Smart provides options to perform various operations on the 

photo like adjusting RGB and CMY values.  

 Modifying RGB and CMY values 

1. Load the Template on the Canvas 

2. Select the Photo on which you want to do the Color Balancing 

3. Click the  Adjust button in the Effects window to load the options in the Gallery 



 

3. Now one by one move the CMY and RGB sliders to change the CMY and RGB values 

 

4. The changes to the photo/object gets instantly applied 

5. Click the  Reset button to discard all the changes made to the photo/object for RGB and CMY 

collectively 

  



Cyan <-> Red    

 

 

 

            

 

 

CYAN ORIGINAL RED 

  

 

 

 

 

 

 

 

 

 

 



Magenta <-> Green    

 

 

 

            

 

 

Magenta ORIGINAL Green 

 

 

 

 

 

 

 

 

 

 

 



Yellow <-> Blue    

 

 

 

            

 

 

Yellow ORIGINAL Blue 

 

GreyScale 

DG Foto Smart also provides the option to convert a color photo or an object to Greyscale in the Adjust 

Window.  

1. Consider the following Template Page 



 

2. Select photo/object 

 

3. Click the  Adjust button in the Effects window to load the options in the Gallery 



 

4. Click on the    Greyscale Button 

5. The color Photo/Object turns Greyscale 



 

6. Also notice that there will be an Orange outline around the Greyscale  button 

7. To return back to the Original Color, Click the  Greyscale button again. This will revert back 

to the original color 

 

 

 



Applying Black and White Presets 

DG Foto Smart provides a huge library of Black and White Presets which can be applied on the Photo in 

the Adjust Window 

These presets are a combination of Greyscale and Brightness properties. 

1. Consider the following template page 

 

2. Select the Photo/Object 

 



3. Click the  Adjust button in the Effects window to load the options in the Gallery 

 

4. Select the Category of the Preset from the Drop down 

 



5. It will load all the presets for Black and White 

 

6. Double click on the Preset. You will see an Orange outline around the Preset which is used 

 

7. It gets instantly applied on the Photo/Object 



 

8. Also the Greyscale button will have an Orange Outline and the Brightness Slider will have 

Orange color and the Value will be displayed in the Text Box 

 

9. If you want to reset. Just click on the  Reset all button and the Photo will change back to 

color 



 

 

Using Instant Ready Tones 

DG Foto Smart provides options to perform various operations on the photo like applying ready color 

tones to the Images/object including Sepia 

There is a huge library of Tones Presets available in the Effects Gallery of the Effects Window 

  

1. Consider the following template page 



 

2. Click on a photo/object to select it. 

 

3. Click the   Effects button in the Effects Window to load the various tones in the Gallery. 



 

4. Select the appropriate Category from the dropdown in the Preset  

 

5. Double Click on any of the preset tones to apply a ready tone to the photo/object. 



 

6. The tone gets instantly applied on the Photo 



 

7. You will also see an Orange Outline around the used tone 

 

 

 

 



Flipping Pages (Horizontal & Vertical) 

DG Foto Smart allows you to Flip the Template Pages at the click of a button.  You can flip the 

Template Horizontally or Vertically 

  

1. Consider the following Template Page. Let us now Flip this Template Page 

 

2. Click the   Horizontal/Vertical Flip Page Button.  

3. The Template in the work area immediately gets flipped as per your selection of vertical or 

horizontal.  

 Horizontal Flip  



 

 Vertical Flip  

 

 

4. All Object position for Background, Shapes, Text, Photo & Clipart gets flipped.   

5. However the objects like Images, Photo as Background and Text do not get flipped individually.  

6. The Gradient Color positions also gets flipped in case of a Background with Gradient  

   



Flipping Images/Objects on the Template Page 

The options for flipping the Images/objects are available in the Content Toolbar which appears below 

the selected Photo/Object  

  

1. Consider the following template page 

 

2. Click on the photo/object on the template which needs to be flipped. 

 



3. Content Tool Bar will be displayed below the selected Photo/Object 

 

3. Click on the Flip Button and  The options for Horizontal and Vertical flip will be displayed 

 

4. Choose the Vertical or Horizontal Flip Option and the selected photo gets instantly flipped as per 

the selection. 

Original 

 

Flip Horizontal 

 

  

 

 

 



 

 

 

 

Original 

 

 

Flip Vertical 

 

Flipping Frames applied on Images  

DG Foto Smart allows you to flip Frame applied on the Photo Individually without flipping the Photo 

1. Consider the following Template Page 



 

2. Select the Photo on which you want to flip the Frame 

 

3. A Content Toolbar will be seen below the Photo 

 

4. Click on the  Frame Button in the Content Toolbar 

5. Select the Flip Vertical or Horizontal options 



 

6. The Frame Gets flipped instantly as per the selection without Flipping the Photo 

Horizontal Flip 

 

Vertical Flip 

 

 



Flipping Masks applied on Images  

DG Foto Smart allows you to flip Masks applied on the Photo Individually without flipping the Photo 

1. Consider the following template page 

 

2. Select the Photo on which you want to flip the Mask 

 

3. A Content Toolbar will be seen below the Photo 



 

4. Click on the  Frame Button in the Content Toolbar. It will show the Flip Options 

 

5. Select the Flip  Vertical or  Horizontal options 

6. The Mask Gets flipped instantly as per the selection without Flipping the Photo 

Flip Horizontal 

  

Adding Multiple Outline to Template Images 

DG Foto Smart allows you to apply three types of Outlines on a selected object. These three types 

include Inside, Outside and Center types.  

Let us now apply various types of outlines to the photo.  

  

1. Consider the following template page 



 

2. Click on a photo on the template page to select it. 

 

2. Click the   Outline Button in the Effects Window to load the various options in the Outline 

Window. 



 

 

3. Click the Inside Outline Color button on the Inside Outline Slider to select a color for the Outline 

 

4. It will automatically make the Inside Outline selected. 

 

5. It will load the color selection window 



 

6. You can also use the  color picker to choose any color on the screen 

7. The selected color gets displayed in the color box 

 

8. Drag the Inside Slider to vary the thickness of the Inside Slider.  

 

9. You can also type a Value in the  Text box to get the desired thickness  

10. The Outline gets applied immediately 



 

11. You can also change the opacity of the Outline 

12. Drag the Outline Opacity slider   to make the Outline 

Transparent by selecting the respective Outline or by selecting all the Outlines that are applied 

 

13. The Outline becomes soft transparent instantly on releasing the mouse button. Also notice that 

the slider color changes to Orange, indicating a change 

 



14. You can also in the similar way add the Center type  and the 

Outer type of Outline by adjusting the corresponding sliders 

15. You can see the Outlines applied on the selected photo 

 

16. You can click the   Reset button to individually remove the outline or click on the   Reset 

All to remove all the Outline and its properties applied 

 

DG Foto Smart provides a huge library of Presets which can be used for adding Outline to a photo or 

multiple Images 

1. Consider the following template page 



 

2. Select the Photo 

 

2. Click the   Outline Button in the Effects Window to load the various options in the Outline 

Window. 



 

3. Click on the Preset drop down and select the category 



 

4. All the presets from the Selected Category will be displayed 

 

5. You can also sort the Presets by Named and Used 



 

6. Double click on the Preset 

7. It gets instantly applied on the Photo/Object 

 

8. You will see an Orange outline around the Preset which is used 

 



9. Also the value will be displayed on the corresponding slider 

 

 

 You can also apply outline to multiple Images at a time, by selecting the all the Images and 

applying the required outline 

 One point on the Slider corresponds to one pixel. 

  

Keyboard Shortcut Function 

F10 Loads the Effects Options in the Gallery 

   

  

Adding Shadows to Template Images/Objects 

You can apply shadows to the Images or objects on the template pages. Furthermore, you can also 

apply shadow distance, angle, softness and opacity in DG Foto Smart. All these options are available in 

the Effects window under the tab 'Shadows'  

  

Let us see how.  

1. Consider the following template page 



 

2. Click on a photo/object on the template page to select it. 

 

3. Now click the  Shadow tab in the Effects Window to load the Shadow options  



 

4. Drag the Shadow Distance Slider to vary the Shadow 

distance. Alternately, you can also enter values in the text box. 



 

5. Drag the  Shadow Angle Slider to vary the angle of the 

shadow. Alternately, you can also enter values in the text box. 

 

6. To apply opacity to the Shadow, drag the  Shadow Opacity 

slider. Alternately, you can also enter values in the text box 



 

7. To apply Shadow softness drag the Shadow Softness Slider. 

Alternately, you can also enter values in the text box 

 

8. Click the Shadow Color button to open a Shadow Color Dialog. Select a proper 

color and click the Ok button.  



 

9. The selected color also gets displayed in the color button  

 

 

10. You can click the   Reset button to individually remove the Shadow properties  or click on the  

 Reset All to remove all the Shadow properties applied 



 DG Foto Smart provides a huge library of Presets which can be used for applying Shadow to a 

photo/object or multiple Images/objects 

1. Consider the following template page 

 

2. Click on a photo/object on the template page to select it. 

 

3. Now click the  Shadow tab in the Effects Window to load the Shadow options  



 

4. Click on the drop down list next to the preset and select the category 

 

5. All the presets from  the Category will be displayed 



 

6. You can also sort the preset by Name and Used 

 

7. Double click on the Preset 

8. It gets instantly applied on the Photo/Object 



 

9. You will see an Orange outline around the Preset which is used 

 

10. Also the values for the preset will be seen in the respective panels 



 

 

Adding Multiple Glow to Template Images 

The Effects window of DG Foto Smart provides options for applying Glow effects to the Images or any 

other selected objects. You can apply Inside & Outside type of Glow together. You can even vary 

parameters like Glow Spread and Opacity to create wonderful effects.  

  

1. Consider the following template page 

 

2. Click on a photo/object on the template page to select it.  



 

3. Click the  Glow Button in the Effects window to load the Glow options in the window 



 

4. Select the Glow which you want to apply  

5. You can also select the color for Glow. For this click the Glow  Color button.  

6. This will open a Glow Color Dialog window. And select an appropriate color from the color pallet or 

use the color picker tool. Click the Ok button when done.  



 

7. The New color is seen on the color button  

8. Move the  Inner Glow Spread slider to vary the Glow spread. 

Alternately, you can also enter values in the corresponding text box. This will add an inner glow to 

the selected photo or object of the selected color and Size. 

 

9. Similarly you can also apply the outer glow 



 

 

10. You can also change the opacity of the Glow 

11. To change the Opacity of the Glow. Select the Glow for which you want to reduce the Opacity .You 

also have the option to select both the Glows.  

12. Now Move the  Opacity slider  to change the Glow opacity. 

Alternately, you can also enter values in the corresponding text box.  

 



13. You can click the   Reset button to individually remove the Glow properties  or click on the   

Reset All to remove all the Glow properties applied 

 

You can also apply Glow effect to multiple photo/objects at a time, by selecting all the Images/object 

at one time 

  

  

Applying Background 

You can make your template pages exclusive by adding background. DG Foto Smart allows you to 

apply background to the pages in many different ways including -  

 Solid Color 

 Gradient 

 Texture  

 Setting Photo as a Background 

Applying a Solid Color Background 

This option allows you to apply a solid color of your choice as a background to match your template 

page.   

1. Consider the following template page. 

mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Applying_a_Solid_Color_Background.htm
mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Applying_a_Gradient_Color_Background.htm
mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Applying_a_Texture_Background.htm
mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Setting_Photos_as_Background.htm


 

 

2. Click the Bg Color Button on the Content Tool Bar which appears on the Left Hand side of 

the Page when selected  

 

3. The Select Color dialog box is displayed.  



 

 

4. The Solid Color tab will be selected by default 

5. Select an appropriate color by clicking on the color palette and moving the color slider. 

 



6. You will see that the Background Color and the Color of the Bg Color button changes as  per the 

selected color 

 

7. You will also get a preview of the New Color which is selected and the Current Color which is on 

the Template Page 

 

8. You can also check the color values for  

 RGB,  



 

 CMYK, 

 

  HSV(Hue Saturation Value), 



 

  GreyScale 

 

9. It also provides   default black and white colors. Simply click on either black or 

white and it gets applied on the page.   



10. Click on the  OK button to apply the color 

11. The color gets applied on the page 

 

12. To select an exactly matching color from the entire visible area on DG Foto Smart Interface, you 

can make use of the color picker tool and make your template page look exclusive. 

8. Simply click the  Color Picker tool button. Notice that the cursor gets converted to the 

Color Picker tool. 

  

9. Move the Color Picker tool across the entire area of the screen to pick up a color.  

10. Notice that as you move the color picker tool, there will be a preview box just above the color 

picker icon which displays the color as you move the color picker.  

 



 

 

11. Click when you find the appropriate color. 

12. The color will be seen applied on the page and also the Bg Color icon color will change to the 

selected color.  

 



Also note that all that when you select the background color, the same background color will be added 

to all new pages that will be added later 

Applying a Gradient Color Background 

DG Foto Smart provides different types of Gradient Presets. 

This option allows you to apply a Gradient Color to your template page. You can also choose the angle 

of the Gradient flow 

  

1. Consider the following template page. 

 

 

2. Click the Bg Color Button on the Content Tool Bar which appears on the Left Hand side of 

the Page when selected  



 

3. The Select Color dialog box is displayed.  

 

 

4. Click the  Gradient Color button.  



 

 

5. Click the Drop down to select various Gradient options. 

 

6. Select the option and click on the gradient color  



 

7. The color will be instantly displayed on the page 

 

8. You also have the option to change the Angle of the Gradient 

9. To change the direction of the Gradient, move the slider next to the Angle. You can also type a 

value in the text box 

 



10. Notice the color change on the page with the angle of gradient color. 

 

11. Click OK  to apply the selected gradient color as a background. 

 

 

 



Applying a Texture Background 

This option allows you to apply bundled as well as your own textures as a background to match your 

template page. The applied texture will automatically resize and fit according to your page size.  

DG Foto Smart allows you to make use of your own files in Targa, TIF, JPEG or BMP formats as a texture 

background. 

  

1. Consider the following template page. 

 

2. Click the Backgrounds button   to load the texture background library into the 

Gallery. 

 

3. Click on an appropriate category. 

 



 

4. Locate the desired texture and double-click on it. Notice that the selected texture gets a number 

indicated on it which shows the number of times the texture is used in the project. 

 

5. The specified texture automatically gets applied in the background of the page. 

 

6. The background will also automatically get resized to match the page size selected. 

7. If you want to zoom into the background you can do so by clicking keeping the zoom 

button pressed and moving the mouse upwards or downwards. Release the mouse once the 

desired zoom is acquired. 



 

8. You can also pan the background with the PAN tool. Select and Keep the mouse clicked on the 

 Pan tool and move the mouse till the required panning is arrived and release the mouse. 

 

9. You can remove an applied texture by clicking the  Delete button on the Content toolbar 

 Remember that on removing an applied texture, the color set for the background is displayed 



 You can import folders on the hard disk using the method explained under mapping folders 

section. 

  

  

Applying a Photo as a Background 

This option allows you to turn a photo as a photo background at the click of a button. 

The photo will automatically get cropped and fit as a background according to your page size. DG Foto 

Smart allows you to make use of your own Images in Targa, TIF, JPEG or BMP formats for applying as a 

Background. 

  

1. Consider the following template page. 

 

 

2. Click the  Images button to load the library of Images in the Gallery. 

3. Click on an appropriate category. 



 

4. Click on any photo from the Gallery to select it. 

 

5. Click the  Set as Background button. 

6. The selected photo gets automatically cropped and gets applied as a photo background. 

 

7. Also notice that the background has an Opacity applied automatically 

8. To know the value of the Opacity or to modify the opacity. Click the Filters Icon in the Effects 

window 

9. You will see the value of the Opacity applied 



 

Flipping Background Photo 

DG Foto Smart also allows you to flip the Background Photo.  

1. Consider the following Template Page 

 

2. Select the Background 

3. Click on the  Flip Button on the Content Toolbar which appears on the left had side of the 

page 



 

4. It will load the  Flip Horizontal and  Flip Vertical option 

5. Click on the Flip Horizontal or Flip Vertical icon. 

6. The Background gets flipped instantly 

Horizontal Flip 

 

7. To delete the background click on the  delete button in the Content Tool bar 



Cropping/Adjusting the Photo Background 

1. Consider the Following Page 

 

2. If you want to zoom a photo on the canvas, you can do it by using the  Zoom Tool.  

3. Keep the zoom button pressed and move the mouse upwards or downwards. Release the 

mouse once the desired zoom is acquired. 

 

4. Repeat the above step to zoom out the photo 



5. To adjust the photo, you can use the  Pan tool. 

6. Keep the mouse clicked on the Pan tool and move the mouse till the required panning is arrived 

and release the mouse. 

 

Changing the Layout  

DG Foto Smart allows you to change the template page layout automatically and also Manually  

Let us see how to change the layout on a page. 

   

Changing the Layout Manually 

  

1. Consider a Template page. 



 
  

2. Click the  Layout button to load the layouts in the gallery. 

 

3. Select the Category from the drop down list under Stock 

 

4. It will load all the layouts from that category 

 

5. You can see the combination of Layouts in the gallery categorized according to the number of 

Images  



 

6. Select the Number of Images based on the Images on the template page and all the layouts for 

that particular number of Images will be displayed 

 

 

7.   You can apply the desired Layout on the Page by Simply Dragging the desired layout in the 

Gallery and dropping it on the Page or by Double Clicking on the Layout in the Gallery, 

 

8. The layout will be applied in an instant.  

 



9. If the Layout selected has more number of Images then the Images on the page then the Images 

will get added in the Images place holder and the remaining photo placeholder will be blank. 

You can add a photo in this place holder from the Images Gallery 

 

10. If the Layout selected has less number of Images then the Images on page, then the extra 

Images will be deleted 

 

Changing the Layout Automatically 

DG Foto Smart provides you the option to change the layout of the Page Automatically through the 

Shuffle Button  



1. Consider a Template page. 

 
  

2. Click the   Shuffle button on the toolbar 

 

3. It will change the layout of the page as per the number of Images on the current page instantly 

 

4. Every time you click on the shuffle button it will load a new layout 



 

Please Note: Changing the Layout will remove all the properties applied to the Images and 

also any other material applied on the pages like cliparts or text 

Changing Theme 

 DG Foto Smart allows you to change the theme into your current project. In order to change the theme 

of your theme page, you need to select the theme from "Change theme" window. This process is called 

"Changing the Theme". 

 

1. To change the theme into your current product, Ensure that the Project is open on the canvas 



 

2. You can also view the pages in the Story Board 

 

3. Click the  Format Menu option click on the Change Theme button in the 

           

4. This will open Change theme window. 



 
          

5. Choose the Mode  

 

6. Select an appropriate theme style according to your choice from various categories of themes  

 

7. Click the  Apply button. 

  

8. The selected theme style gets applied to all theme pages in the currently open project. 



 

9. Also notice the changes in the Story board 

 

  

Replicating Object Properties 

DG Foto Smart provides a feature in which you can replicate properties of an object over another object 

of the same type.  

These properties include applied masks, borders, tones and almost all the properties from Effects 

window.  

Let us see how: 

1. Consider the following template page. 



 

2. Notice that one of the Images here, have a Border, Mask and Shadow already applied on it. 

 

3. Let us now replicate all these properties over the other Images. 

4. Select the photo containing the applied properties. 



 

5. Now click on the  Properties icon on the Content tool bar. 

 

6. It will display further options in the Properties 

 

7. Click the  Copy Properties icon. 

6. Keeping the CTRL key pressed, click on the rest of the Images one by one to select them. 



 

7. Now click on the Properties  Icon in the Content toolbar 

8. Click the  Paste Properties Icon from the list 

9. Instantly the properties of the first photo get applied on all the Images at one go. 

 

 



10. To remove these properties, Select all the Images from which you want to remove the 

properties 

11. Click the  Properties icon on the Content toolbar  

12. Click on the  Clear Properties icon. 

12. The applied properties get instantly reset. 

13. You can also use the Copy, Paste and Clear Properties from the Object Menu in the Menu Bar 

 

 

The principle of replicating properties is applicable for almost all the features under Photo Edit, Color 

Corrections and Effects category including Rotate and Flipping options. You can replicate properties of 

shapes also. The properties like outline color, outline thickness and fill color can be replicated. 

  

 

  



Resetting the Image Size 

The Reset Image option allows you to resize the image with respect to its width for maintaining the 

aspect ratio. This feature is very useful if you have accidentally stretched or cropped the photo 

manually.  

 

1. Consider the following photo on the template page. 

 

 

2. Assume that while cropping and resizing, you have accidentally cropped the photo a lot but 

want the photo to be adjusted in the same size 



 

3. To do that click on the  reset button in the content toolbar 

 

 

4. The photo gets resized with respect to its width, maintaining the aspect ratio. 

 

 



Swapping Images 

DG Foto Smart allows you to swap the positions of any two Images on the template page. 

  

1. Consider the following template page, having two Images, whose position you wish to swap. 

 

2. Click on the first photo whose position needs to be swapped. 

 

 



3. Now Click on the  Swap button on the Content Toolbar 

 

4. You will see a small preview of the image you just selected to swap next to the mouse pointer 

 

5. Click the second photo.  

6. The position of the two Images interchanges instantly.  

 

If the positions have some properties associated with it, they remain as it is, only the positions of the 

Images interchange. This option is applicable only for two Images at a time. 

  

 

 

 



Using Shapes 

DG Foto Smart provides huge library of ready to use shapes. You can apply and use all the properties 

and functions to the shape except Frames, Masks and Outline 

 

Applying Shapes 

To apply a shape on the template page 

1. Consider the following template page 

 

2. Click on the  Shapes button to load the shapes library 

 

3. Choose the appropriate Category 



 

4. Shapes of the corresponding are displayed in the Gallery 

 

5. Drag and Drop the Shape on the Template Page 

6. You can also double click the shape. It gets applied on the center of the page 

 

7. You will also notice a count on the Shape used. This indicates the number of times the shape has 

been used in the current Project 



 

8. You can move and place the shape any where you want 

 

9. You can also rotate the shape 



 

10. You can also resize the shape 

 

 

11. You can apply all the properties to the shape except Frames, Masks and Outline 

 

 



Applying Color to Shapes 

DG Foto Smart allows you to add colors to the shape 

1. Select the Shape for which you want to add color. The default color of Shape is black 

 

2. Click on the  Shape Color button in the Content Toolbar 

 

3. Shape color panel will open  

 

4. Move the Slider to change the color of the Shape. You will also see a preview of the color 

selected and the color gets instantly applied on the shape 



 

5. You can also choose a color from a color palette 

6. Click on the  Color Pallete button 

7. It will load the change color window 

 

8. You can add only Solid Colors 



9. You are also provided with a  color picker to choose a color from anywhere on the screen 

10. The color gets instantly applied 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Deleting Shapes from Template Pages 

1. Select the Shape which you want to delete 

 

2. Click on the  delete button on the Content Toolbar which appears below the selected shape 

3. The Shape gets deleted instantly 

 

4. You will also notice the count of the deleted shape in the Shapes Gallery decreases 

Before Deletion 



 

After Deletion 

 

 

 

Applying Text 

You can add texts and titles in any language on the template pages. You can use all true type fonts 

installed on the system for better quality.  

  

Applying Text on Template Pages 

1. Consider the following template page 



 

2. Click the Text button in the Effects Window to load the text options in the Gallery. 



 

3. Now Click on the  Add Text button  to add a text on the page 

4. Notice that a text box appears on the page. 



 

5. You can move the Text box any where on the page. To move the Text Box, place your mouse 

pointer to the center of the Text Box with a white square. The Move Icon will be displayed 

 

6. Keeping the mouse clicked, you can move the text box anywhere you want and release the 

mouse 



 

7. To type a Text in the Text box single click inside the box and you will see a text icon inside the 

box 

 

8. Start typing a Text in the Text Box on the page. 



 

9. The text gets adjusted as per the size of the Text Box.  

 Font Size 

1. To increase/decrease the text size  

2. Select the Text in the Text Box 

 

3. Select the size of the font from the dropdown next to the  Font Size 



 

 

4. Remember that in DG Foto Smart, you can change the font size only through the Font Size 

Control. 

5. Select the Size  and the text size instantly changes in the text box 

 

 

Modifying the Size of the Text Box 

1. Select the text box for which you want to increase the size. 



 

2. Drag any one of the Corner by keeping the mouse pressed and releasing once the desired size is 

reached 

 

3. Notice the Text gets readjusted 



 

 

Font Type 

1. Select the Text in the Text Box 

 

2. Click the down arrow below the  Add text button. 

 



3.  It will display all the fonts available 

 

4. Select the font you like 

 

5. The selected font type gets applied instantly 

 

 

6. You can also make the Font  Bold,  Italic or  Underline from the Text Gallery 

 

  

 

 



Text Color and Background Color 

1. To fill the text with a solid color, select the Text  

 

2.  Click the  button next to Font to open Select Color dialog box. 

 

3. Select the appropriate color and click the OK button. 

4. You can also use color picker to choose any color from the Screen 



5. The selected color gets applied instantly 

 

6. Alternately you can also click on the  Fill color button on the Content toolbar 

7. Adjust the color slider to change the color of the text 

 

8.  Or click on the  Palette button to open the Choose Color window to a select a solid color as 

mentioned in steps from 2 to 4 

 

To add a Background color for Text 

1. Consider the following template 



 

2. Select the Text  

 

3. Click on the Button next to Background in the Text Panel 



 

4. It will load the Select Color window 

 

5. Select the appropriate color and click the OK button. Alternately you can also use the color 

picker to choose any color on the screen 

6. The color gets instantly applied 



 

 

Text Outline with Color 

You can apply 3 color outlines to a Text. 

1. Consider the following template 

 

2. Select the text 



 

3. Click on the  Outline Button in the Effects window to load the different Outline Properties 



 

4. Choose the type of outline you want to apply. You can apply one or all the outlines 

 

5. Drag the corresponding Outline slider to apply an outline to 

the text. 

6. You can also change the color of the outline by clicking the  Outline Color button. 



7. Select the appropriate color and click the OK button in the Color dialog box. 

 

8. The outline gets instantly applied 

 

9. Similarly you can apply all outline on the text by dragging the corresponding slider 



 

10. The outline gets instantly applied on the text 

 

11. You also have the option to change the opacity of the Color 

12. Select the outline for which you want to change the opacity 

 

13. Drag the slider of the opacity to change the opacity of that particular outline 

 

14. Changes gets immediately applied 



 

 

Text Glow with Color 

You can apply 2 types of Glow viz. Inner and Outer Glow to a Text. 

1. Consider the following Template 

 

2. Select the text 



 

3. Click on the  Glow Button in the Effects window to load the different Glow Properties 



 

4. Choose the type of Glow you want to apply. You can apply one or all the Glows 

 

5. You can also change the color of the glow by clicking the  change color button 

6. Select the color from the window 



 

7. Click on the  OK button 

8. Drag the corresponding Glow slider to apply an outline to 

the text. 

9. The glow gets applied on the Text 

 



10. You can also apply both the Glow by moving the slider of the corresponding glow 

 

11. The glow gets applied instantly 

 

12. You can also change the opacity of the glow by selecting the glow for which you want to change 

the opacity 

 

13. Now move the slider of the opacity 

 

14. The opacity for the selected glow changes instantly 



 

 

  

Drop Shadow on Text 

You can apply a shadow to a text and also select a shadow color 

1. Consider the following Template Page 

 

2. Select the text 



 

3. Click on the  Shadow Button in the Effects window to load the different Shadow 

Properties 



 

4. Move the Distance slider to apply shadow distance to the 

text. You can also type the value in the text box 



 

5. Move the Angle slider to apply shadow angle to the text. 

You can also type the value in the text box 

 

6. Move the Opacity slider to apply reduce the Shadow 

opacity. You can also type the value in the text box 



 

7. Move the Softness slider to apply softness to the Shadow 

text. You can also type the value in the text box 

 

8. You can change the color of the shadow by clicking the  Color button and selecting 

the color to apply a color to the drop shadow. 

 



9. You can also Apply Shadow Style from the  presets.  

 

  

Text Opacity 

You can also change the opacity of Text. 

1. Consider the following Template page 

 

2. Select the Text in the Text Box 



 

3. Click on the  Text button in the Effects window to load the Text Options 

 

4. Move the Slider under Opacity in the Text Gallery 

 

5. The changes gets applied instantly 



 

Text Alignment 

You have the option to align a Text in the Text box. This feature will be very useful if you have 

paragraphs of Text 

1. Consider the following Template page 

 

2. Select the Text in the Text Box 



 

3. Click on the  Text button in the Effects window to load the Text Options 

 

 

4. Choose the Alignment Option from Left Align, Center Align, Right Align and Justify. 

5. Click on the Left Align  

6. The Text gets left aligned instantly 



 

7. Similarly you can use other alignment options on the text 

  

Rotating Text 

1. Consider the following Template page 

 

2. Select the Text Box which you want to rotate 



 

3. You will see a  rotate button above the Text Box.  

4. Click the Rotate button by keeping the left mouse button pressed and moving it till the desired 

rotation is obtained. Release the Mouse 

 

5. The Text Gets rotated instantly 



 

  

Text Editing 

1. Consider the following Template page 

 

2. For editing a portion of text, click on the text and a Type Cursor appears. 



 

3. Now you can perform editing of text in the text box 

 

Using External Editor 

DG Foto Smart allows you to use any external image editor to do any modification on image. 

Setting up External Editor 

To use the External Image Editor, first you would have to set the path of the Editor 

1. Click on the Edit Menu  

2. Select Preferences. 

 

3. Now select External Editor from the list 

 

4. Select Editor Window will appear 



 

5. Browse to the executable file of the External Editor and select it 

 

6. Click on the  Open Button 

7. The External Image editor is successfully mapped with DG Foto Smart for editing of Images 

Alternately, if you have not set the External Editor by the above method.  



1. You can right click on the image which you want to edit and select Edit Photo.  

 

2. If the External Editor is not mapped, it will open the Select Editor window 

 

3. Browse to the executable file of the External Editor and select it 



 

4. Click on the  Open Button 

5. The External Image editor is successfully mapped with DG Foto Smart for editing of Images 

Using External Editor 

1. Consider the Template page 

 

2. Select the Image which you want to do changes  



 

3. Right Click on it and Select Edit Photo 

 

4. The Selected External Editor opens with the photo selected 



 

5. Do the changes in the External Editor and Click save the changes in a different folder. 

6. Now to get the photo in the project, kindly import the folder in the Photo Gallery and add the 

photo on canvas 

Please note that you can use 32 bit alpha channel Images with tiff, png, targa etc extensions 

  

Working with Story Board 

Storyboard is a place where you will see all the pages and the cover of the project as thumbnails. You 

can perform various function in the storyboard 

Viewing Story Board 

1. Click on the  Storyboad button to load the story board gallery 

2. You will see Cover(only if you have selected a cover for your project) and the pages as 

thumbnails on storyboard 



 

3. You will also see page number below the thumbnails for reference 

 

4. As you go on adding pages it will get added as a thumbnail on story board. 

5. If you save the changes on the Page it gets immediately reflected in the storyboard 

6. You can scroll through the thumbnails on the story board by clicking the left or the right arrows 

in the story board 

 

Rearranging Pages in Story Board 

DG Foto Smart also allows you to rearrange template pages in the story board at any point of time by a 

simple Drag and Drop method. 

1. Select the Thumbnail that you want to move. 

 

2. Drag the thumbnail and drop it where you want the thumbnail to be on the story board 

 

3. Notice the Pages get rearranged accordingly 

 



Adding and Deleting Pages 

DG Foto Smart also allows you to add or delete a Page from the Storyboard window 

Add Page 

1. Select the page after which you want to add a blank page 

 

2. Please note the page count before addition of the blank page 

 

3. You can add blank page using the  

  Add button from Storyboard gallery or 

    

   Add button  on the Library Bar Click on the Add Page button 

 

4. A blank page will get added next to the selected page 

 

5. You will receive a success message on addition of Blank Page 



 

6. Also notice the change in the count of number of pages after addition 

 

Delete Page 

1. Select the Page which you want to delete.  

 

2. Please note the page count before deletion of the page 

 

3. You can Delete a page using the  

1.  Delete button from Storyboard gallery or 

    

2.   Delete button  on the Library Bar  

 

4. Click on the Delete Page button 

5. You will receive a confirmation message 



 

6. Click on the YES button to confirm delete 

7. You will receive a Success deletion message 

 

8. The page gets deleted instantly 

 

9. Also notice the change in the count of number of pages after deletion 

 

 

Locking / Unlocking Objects 

 

Many a times it happens that, accidentally you may move an object or a photo which is placed already in 

a tight composition. In this case it becomes difficult to rearrange the object again as per the earlier 

composition. 

To avoid this situation DG Foto Smart allows you to lock and unlock objects. 

1. Click on the object to be locked or Unlocked. 



 

2. If the Object is unlocked then you will see the  unlocked icon on the content toolbar 

 

3. If the Object is locked then you will see the  locked icon on the content toolbar 

 

4. Click on the lock/unlock button in the content tool bar which appears after you select the object 

5. Notice the color of the select changes. If the Object is unlocked, the color of the selection is 

green and if the Object is locked then the color of the selection is brown 

6. Now, when you select the locked object and try to move, you will see a locked icon next to the 

mouse pointer 



 

 

 

 

 

 

 

 

 

 

 

  



Lock object-    
Lock object in lock position  

 

 

Unlock object-  Lock object in unlock position 



 

Saving Your Project 

1. For saving your project, simply click the  Save button in the standard toolbar.  

  

2. Alternately, you can use CTRL+ S on the keyboard. 

3. Notice that the thumbnail in the Story board get updated instantly after saving. 

 

Keyboard Shortcut Function 

CTRL+S Saves the Album/Project 

  



Opening an existing Album/Project 

While opening existing projects created in DG Foto Smart, you can get to see the thumbnail of all the 

projects created. 

From Canvas 

1. Consider the following screen 

 

2. Click the Open Album/Project button on the standard toolbar  

 

3. or Select open Project from the File Menu.  



 

4. It will ask confirmation before closing the existing open project. Click on the appropriate option 

and proceed 

 

5. The Homepage of the Software will be loaded. 

 



6. On the right Hand side of the Homepage, there will be a All Project Section   

 

7. In all project section all your created projects will be displayed as thumbnails.  

 



8. Move your mouse cursor on the Thumbnail and a tool tip will be displayed with the Number of 

Pages and Size information about the project 

 

9. Double click on the thumbnail to open the project on the Canvas 

 



 

 

 

From Homepage 

1. On the Homepage of the software which gets loaded when the software starts 

 

2. On the right Hand side of the Homepage, there will be a All Project Section  



 

3. In all project section all your created projects will be displayed as thumbnails.  

 

4. Move your mouse cursor on the Thumbnail and a tool tip will be displayed with the Number of 

Pages and Size information about the project 



 

5. Double click on the thumbnail to open the project on the Canvas 

 

 

 

Deleting a Project 

DG Foto Smart provides an option of deleting unwanted projects created in DG Foto Smart without 

even having the need to open them to see the details. 

1.  On the Homepage of the software which gets loaded when the software starts 



 

2. On the right Hand side of the Homepage, there will be  All Project Section 

 

3. In “All Projects” section all your created projects will be displayed as thumbnails.  



 

4. Move your mouse cursor on the Thumbnail and a tool tip will be displayed with the Number of 

Pages and Size information about the project 

 

 

5. Select the Project which you want to delete 



 

6. Click on the  delete button. 

 

7. Confirmation window will appear 

 

8. Click on  YES to confirm delete 

9. The project gets deleted immediately 



 

10. You can also delete multiple projects by selecting all the projects which you want to delete and 

clicking on the delete button 

 

Resizing Galleries 

DG Foto Smart allows you to resize the gallery window in order to view more thumbnails 

To resize the gallery 

1. Consider the following Screen 



 

2. Move the Mouse cursor on icon on the Gallery window.  

 

3. The cursor changes to  

4. Click and Drag the Gallery Window  to the desired size and release the mouse 

5. Notice the Gallery Window size changes and the size of the canvas decreases 



 

Zooming Canvas area 

 DG Foto Smart allows you to zoom the canvas area and also to move to a particular section in the zoom 

area 

1. Consider the following Template screen 



 

2. Click and drag the zoom slider situated above the gallery window 

 

 

3. Move the mouse pointer on the slider and you will see the percentage of zoom 

 

4. Move to slider to get the desired Zoom 

 

5. The page will get zoomed as shown below 



 

6. You will also see a zoomed preview screen 

 

7. To move to a particular section on the zoomed page. 

8. Click on the Orange rectangle which appears in a preview section on the canvas 



 

9. Drag the orange rectangle to the desired location 

 

10. Notice that the page on the canvas moves to the desired location 

 

Working in Full Screen Mode 

DG Foto Smart provides a Full Screen mode to display the Canvas Page in full screen. The advantage of 

the Full Screen mode is that you get a full screen view of the entire template page. And what’s more? 

You also have the option of expanding or Collapsing either the Gallery Window or Effects Window on 

demand so that you can work comfortably in this mode.  

1. Consider the following template page. 



 

 

2. For entering into the full screen mode, click the   Full Screen button on the standard 

toolbar. 

 

3. The color of the icon changes to orange  

4. Notice that the Interface changes, with the template page getting displayed in full screen. 



 

 

4. Also notice that in this mode, the gallery, template and the story board are not available for use. 

5. You can expand or collapse Gallery Window or the Effects window Individually 

6. To expand the Gallery Window, click on the  icon  

 

7. The Gallery Window gets expanded and the Collapsible icon changes to  



 

8. To expand the Effect5s Window, click on the  icon  

9. The effects window gets expanded and the collapsible icon changes to  

 



10. For returning back to the normal working mode, click the   Full Screen Mode button on the 

standard toolbar again. 

11. The current page is displayed in the work area along with all the other controls not available in 

the Full Screen Mode. 

 

 

 You can perform cropping action in Full Screen Mode too. Guidelines can also be added in the 

Full Screen Mode, provided the ruler is On.  

Fit to Screen  

Suppose you have maximized the screen and want to get back to its original size. DG Foto Smart 

provides you with the option of Fit to Screen 

1. Consider the Template Screen where the canvas is maximized 



 

2. Click the   Fit to Screen button on the standard toolbar to accommodate the page in the 

work area. 

 

3. The template page in the work area appears in the default size. 

 

 



Using Alignment Options 

DG Foto Smart provides intelligent page based object based and Safe Area based alignment options 

where in you can instantly and accurately align or reposition one or multiple objects collectively. You can 

set equal spacing, equal alignment and equal size on multiple objects at the click of a button. 

 

Related Topics 

Object Based Alignment 

Page Based Alignment 

Safe Area Based 

 

Object Based Alignment 

1. Ensure that in order to use the Object Based Alignment options; you have at least two objects 

on the template page. 

2. Keeping the CTRL key pressed, click to select the Objects, one by one, in order to align them 

with respect to the last selected object. 

 

Let us now use the various Object based alignment options. 

Horizontal Left Align 

This option aligns the Object horizontally with respect to the left of the last selected object 

1. Consider the following template Page 



 

2. Select the object you want to align, ensuring that the object with which the other object has to 

be aligned is selected last.  

 

3. Also note that the last Object selected has a yellow color selection. This will help to identify the 

last selected object 



 

4. Click on the  Align Button to load all the options for Alignment 

 

5. Select the Object Option in the Align tab of Effects window 

 

6. Click on  Horizontal left align option In the Align panel 

 

7. Notice that the objects get aligned to the left of the last selected object 



 

 

Horizontal Center Align 

This option aligns the Object horizontally with respect to the Center of the last selected object 

1. Consider the following template Page 

 

2. Select the object you want to align, ensuring that the object with which the other object has to 

be aligned is selected last.  



 

3. Also note that the last Object selected has a yellow color selection. This will help to identify the 

last selected object 

 

4. Click on the  Align Button to load all the options for Alignment 



 

5. Select the Object Option in the Align tab of Effects window 

 

6. Click on  Horizontal Center align option In the Align panel 

 

7. Notice that the objects get aligned to the Center of the last selected object 

 



Horizontal Right Align 

This option aligns the Object horizontally with respect to the right of the last selected object 

1. Consider the following template Page 

 

2. Select the object you want to align, ensuring that the object with which the other object has to 

be aligned is selected last.  

 

3. Also note that the last Object selected has a yellow color selection. This will help to identify the 

last selected object 



 

4. Click on the  Align Button to load all the options for Alignment 

 

5. Select the Object Option in the Align tab of Effects window 

 

6. Click on  Horizontal Right align option In the Align panel 

 

7. Notice that the objects get aligned to the Right of the last selected object 



 

Vertical Top Align 

This option aligns the Object Vertically with respect to the Top of the last selected object 

This option aligns the Object horizontally with respect to the right of the last selected object 

1. Consider the following template Page 

 

2. Select the object you want to align, ensuring that the object with which the other object has to 

be aligned is selected last.  



 

3. Also note that the last Object selected has a yellow color selection. This will help to identify the 

last selected object 

 

4. Click on the  Align Button to load all the options for Alignment 



 

5. Select the Object Option in the Align tab of Effects window 

 

6. Click on  Vertical Top align option In the Align panel 

 

7. Notice that the objects get aligned to the Top of the last selected object 

 



Vertical Center Align 

This option aligns the Object Vertically with respect to the Center of the last selected object 

1. Consider the following template Page 

 

2. Select the object you want to align, ensuring that the object with which the other object has to 

be aligned is selected last.  

 

3. Also note that the last Object selected has a yellow color selection. This will help to identify the 

last selected object 



 

4. Click on the  Align Button to load all the options for Alignment 

 

5. Select the Object Option in the Align tab of Effects window 

 

6. Click on  Vertical Center align option In the Align panel 

 

7. Notice that the objects get aligned to the Vertical Center of the last selected object 



 

 

Vertical Bottom Align 

This option aligns the Object Vertically with respect to the Bottom of the last selected object 

1. Consider the following template Page 

 

2. Select the object you want to align, ensuring that the object with which the other object has to 

be aligned is selected last.  



 

3. Also note that the last Object selected has a yellow color selection. This will help to identify the 

last selected object 

 

4. Click on the  Align Button to load all the options for Alignment 



 

5. Select the Object Option in the Align tab of Effects window 

 

6. Click on  Vertical Bottom align option In the Align panel 

 

7. Notice that the objects get aligned to the Bottom of the last selected object 

 



 

Vertical & Horizontal Center Align 

This option aligns the Object Vertically and Horizontally Center with respect to the last selected object. 

This feature is very useful if you want to place one photo over another photo exactly at the center 

1. Consider the following template Page 

 

2. Select the object you want to align, ensuring that the object with which the other object has to 

be aligned is selected last.  

 



3. Also note that the last Object selected has a yellow color selection. This will help to identify the 

last selected object 

4. Click on the  Align Button to load all the options for Alignment 

 

5. Select the Object Option in the Align tab of Effects window 

 

6. Click on  Vertical Middle and Horizontal Center align option In the Align panel 

 

7. Notice that the objects get aligned on the Center of  the last selected object 



 

Spacing 

You can also specify the Horizontal and Vertical spacing between Objects 

Horizontal Spacing 

1. Consider the following template Page 

 

2. Select the object between whom you want to have equal horizontal spacing. 



 

3. Click on the  Align Tab in the Effects window 

 

4. Click on the  Horizontal spacing icon  

 

5. Notice that the object get equal spacing automatically  



 

6. You can also specify a  Value or use the Arrow buttons in the Horizontal Spacing Text Box 

 to increase and decrease the spacing between objects 

7. You can also reset the spacing by clicking on the  reset button 

 

Vertical Spacing 

1. Consider the following template Page 

 



2. Select the object between whom you want to have equal horizontal spacing. 

 

3. Click on the  Align Tab in the Effects window 

 

4. Click on the  Horizontal spacing icon  

 

5. Notice that the object get equal spacing automatically  



 

6. You can also specify a  Value or use the Arrow buttons in the Horizontal Spacing Text Box 

 to increase and decrease the spacing between objects 

7. You can also reset the spacing by clicking on the  reset button 

 

Page Based Alignment 

Page Based Alignment options aligns the Objects with respect to the Page.  

Let us now use the various alignment options. 

Horizontal Left Align 

This option aligns the Object Horizontally to the Left side of the Page 

1. Consider the following template page containing two or more Images. 



 

2. Keeping the CTRL key pressed, click to select the objects to be aligned on the page. 

 

3. Click the  Align button on the Effects window to load the align options 



 

4. Select the Page Base Option  

 

5. Click on the  Horizontal Left Align button. 

 

6. The Objects get aligned to the left side of the page 



 

Horizontal Center Align 

This option aligns the Object Horizontally to the Center of the Page  

1. Consider the following template page containing two or more Images. 

 

2. Keeping the CTRL key pressed, click to select the objects to be aligned on the page. 



 

3. Click the  Align button on the Effects window to load the align options 

 

4. Select the Page Base Option  

  

5. Click on the  Horizontal Center Align button. 



 

6. The Objects get aligned horizontally to the center of the page 

 

 

Horizontal Right Align 

This option aligns the Object Horizontally to the Right side of the Page  

1. Consider the following template page containing two or more Images. 



 

2. Keeping the CTRL key pressed, click to select the objects to be aligned on the page. 

 

3. Click the  Align button on the Effects window to load the align options 



 

4. Select the Page Base Option  

  

5. Click on the Horizontal  Right Align button. 

 

6. The Objects get aligned horizontally to the right side of the page 



 

Vertical Top Align 

This option aligns the Object Vertically to the Top of the Page  

1. Consider the following template page containing two or more Images. 

 

2. Keeping the CTRL key pressed, click to select the objects to be aligned on the page. 



 

3. Click the  Align button on the Effects window to load the align options 

 

4. Select the Page Base Option  

  

5. Click on the  Vertical Top Align button. 



 

6. The Objects get aligned Vertically to the Top side of the page 

 

Vertical Center Align 

This option aligns the Object Vertically to the Center of the Page  

1. Consider the following template page containing two or more Images. 

 



2. Keeping the CTRL key pressed, click to select the objects to be aligned on the page. 

 

3. Click the  Align button on the Effects window to load the align options 

 

4. Select the Page Base Option  

  



5. Click on the  Vertical Center Align button. 

 

6. The Objects get aligned Vertically to the Center of the page 

 

Vertical Bottom Align 

This option aligns the Object Vertically to the Bottom of the Page  

1. Consider the following template page containing two or more Images. 



 

2. Keeping the CTRL key pressed, click to select the objects to be aligned on the page. 

 

3. Click the  Align button on the Effects window to load the align options 



 

4. Select the Page Base Option  

  

5. Click on the  Vertical Bottom Align button. 

 

6. The Objects get aligned Vertically to the Bottom of the page 



 

 

Vertical & Horizontal Center Align 

This option aligns the Object Vertically & Horizontally to the Center of the Page  

1. Consider the following template page containing two or more Images. 

 

2. Keeping the CTRL key pressed, click to select the objects to be aligned on the page. 



 

 

3. Click the  Align button on the Effects window to load the align options 

 

4. Select the Page Base Option  

  



5. Click on the  Vertical & Horizontal Center Align button. 

 

6. The Objects get aligned Vertically & Horizontally to the Center of the page 

 

Safe Area based Alignment 

This is similar to the page based alignment. But this Alignment will align the Object within the safe area 

of the Page. 

To Align the Object with reference to the Page but within the safe are. Kindly choose the Safe Area Base 

option in the Align Window. 

Refer to the Page Based Alignment for the working of different alignment options 

Distribution 

You can also have equal spacing between Object using the distribution option. Distribution option works 

with 3 Objects only and is similar to Alignment and Equal Spacing (Refer to Alignment and Spacing 

Option). 

Arranging Multiple Objects 

Most of the time during template page creation, you will find that many objects overlap with other 

objects on the template page. To change the sequence of these objects or to get access to them, DG 

Foto Smart provides the various options. 



 Ensure that you have more than two objects on the template page in order to use this option, consider 

the following template page. 

 Consider the Following Template Page. We will now see the use of different Arrangement Options 

Sent to Back (Last Position) 

This Option will send Object right at the Back of all the Objects i.e the last position  

1. Consider the Following Template 

 

2. Select the Object 



 

3. A Content toolbar will be displayed below the selected Photo 

 

4. Click on the  Arrange Icon  

5. Select the  Send to Back from the option 

 

6. The selected photo goes to the last position. 



 

 

Bring to Front (Topmost position) 

This Option will bring the Object right at the top of all the Objects i.e. the topmost position  

1. Consider the Following Template  



 

2. Select the Object 

 

3. A Content toolbar will be displayed below the selected Photo 

 

4. Click on the  Arrange Icon  



5.  Select the  Bring to Front from the option 

 

6. The selected photo comes to the top position of all objects. 

 

 

Send Backwards (Backward by One Position) 

This option will send the Object back by one position 



1. Consider the Following Template  

 

2. Select the Object 

 

3. A Content toolbar will be displayed below the selected Photo 

 

4. Click on the  Arrange Icon  



5. Select the  Send to Back from the option 

 

6. The selected photo move one position backward 

 

 

 Bring Forward (Forward by One Position) 

This option will bring the Object forward by one position 

1. Consider the Following Template 



  

2. Select the Object 

 

3. A Content toolbar will be displayed below the selected Photo 

 

4. Click on the  Arrange Icon  



5. Select the  Bring forward from the option 

 

6. The selected photo move one position Upward 

 

 

Rulers, Center Lines and Safe Area  

DG Foto Smart provides various useful tools which assist you during the creation of template pages.  

You have the option to view or hide Rules, Center Lines and Safe are. 

Let us see how we show or hide these Options 

The View option in the menu bar provides options to show and hide the Ruler, Center lines and Safe 

Area  

Ruler  

It is the measurement scale which appears at the Bottom and on the left side of the work area. 

The View option in the menu bar provides options to show and hide the Ruler 

1. Consider the following template page 



 

2. To View the Ruler on the canvas area, click on the  View Menu  

 

3. Select the Ruler from the View Menu options 

 

 

4.  It will display a check mark when rulers are visible 



 

5. The Ruler gets  visible on Canvas. 

 

You can also change the measuring unit of the ruler. You have the option to choose between 

Centimeters, Millimeters, Inches and Pixels 

1. Consider the following template 

 



2. Right Click anywhere on the Ruler 

 

3. The current unit will be displayed with a round selection 

 

4. Select the measuring unit from the options provided 

 

5. Notice that the Ruler units changes to the selected measuring Unit 

 

 



 

Center Lines  

They are horizontal and vertical lines intersecting at the center of the template page. They are helpful in 

knowing the precise center of the page. To view or hide Centerlines 

1. To View the Center Lines on the canvas area, click on the  View Menu  

 

2. Select the Center Line option from the View Menu options 

 

 

3.  It will display a check mark when rulers are visible 

 



4. Center Line will appear in Red color on the Page 

 

 

Safe Area 

It is an area defined by you as a margin to avoid cutting during the finishing process. It helps us in 

placing our object so that they do not get cut during finishing. To View or Hide Safe Are 

1. Consider the following template page 

 



2. Notice the grey area around the four corners of the Page. This will be on by default 

3. Click on the  View Menu  

  

4. The Safe area option will display a check mark since it is on by default 

 

5. Click on the Safe Area 

6. Notice the check mark disappears. 

 

7. The safe area will hide from the page 



 

8. To turn it back on just select the safe area option from the view menu 

9. Please note that the size of the grey area will depend on the Value of the safe area that you 

have provided while defining the Album size 

 

 

Using Guidelines and Gridlines 

DG Foto Smart allows you to add Guide Lines & View Gridlines to the template pages. They come very 

handy while composing a page layout. You can also make the Guide Lines universal, i.e. make them 

appear on all the album pages. 

 Guidelines 

These are single lines which you can add vertically or horizontally on a page. You can add as many Guide 

Lines as possible.  

Adding Guidelines 

Before Adding a Guideline, Kindly ensure that the Ruler is Visible on the Canvas 

1. Click on the View Menu to check if the Ruler and Guides options are checked. If not, please 

check it. It will have a check mark  



 

2. Now consider the following album page and follow the following steps 

 

3. Click anywhere on the Vertical Ruler until you see a Blue Color Line appear on the Ruler 



 

4. Drag and Drop the Vertical Guide Line it on the canvas , after dropping you will see a Blue color 

line on the page as shown below  

 

5. Similarly,  Click anywhere on the Horizontal Ruler until you see a Blue Color Line appear on the 

Ruler 

 

6. Drag and Drop the Horizontal Guide Line it on the canvas , after dropping you will see a Blue 

color line on the page as shown below  



 

   

  

  

Deleting the Guide Lines 

  

1.  Consider the following template page 

 



2.  Click on the Guideline. Notice the Guideline color gets bold 

 

3. Drag and Drop the Guideline on the Ruler 



 

4. The Guideline will be deleted from the Page 

 



 

Grid lines  

Gridlines are the perfect alignment tool composing a page and is very easy to use. 

With evenly placed grid boxes, placement of objects becomes very easy. 

Each size of the box is 

Show Grid lines Option  

1. Consider the following template page 

 

2. To View Gridlines on the canvas area, click on the  View Menu  

 

3. Select the Show Grid option from the View Menu  

 

 

4.  It will display a check mark when Gridlines are made visible 



 

5. And Gridlines will be visible on the canvas. 

 

 

Saving Pages as Templates  

You can save a page which you have designed and loaded into the work area so that you can use it 

repeatedly. The page gets saved with the entire composition i.e. the Images, clipart, borders, outlines 

etc.  

You can use this page as a template in any other projects. All the Objects except for Photo gets loaded 

when you use this template in a Project. The Image gets converted into a placeholder to add a different 

image 



 

Let us see how to save Template Page 

1. Load the Page on the Canvas which you want to save as a Template 

 

2. Click on the  Templates Icon to open the Template Gallery 

 

3. Click the User Tab  

4. Below the User tab Select the Category.  

 

5. If there is no Category, Select the  Create category button  

6. Create a category window gets loaded 



 

7. Give a name to the Category and click on the OK button 

 

8. Once the Category is created it will appear in the Drop Down. Select the category 

 

9. Now click on a sub category which will be under the just created category 

 

10. Select a Sub Category 

 

11. Click on the  Save Template button 



12. Save as Template window will appear with the selected category. You have the option to change 

the category too 

 

13. Give a Name to the Template 

 

14. Click on Ok 

15. The Template appears as a thumbnail in the Gallery. 

 

16. You can use this template in any other project by simply double clicking on the template 



 

17. You can also rename the just created category by clicking on the  Edit Category button 

 

18. It will load the Rename Category Window 

 

19. Give a New Name to the category and click on the OK button 

 



20. The New Name will be displayed in the Category List 

 

21. You can also delete the Category by clicking on the  Delete button 

 

22. A delete confirmation window will be loaded 

 

23. Click on Yes and the category gets deleted 

 

Save Layout 

Suppose you have created a template page and you would like to use the Photo composition/layout of 

the page in other projects. DG Foto Smart allows you to save the page as a layout so that you can use it 

in other projects 

 

1. Consider the following template page 



 

2. Click on the  Layout button to open the Layout Gallery 

 

3. Click on the  User Tab 

4. You can select the default category to save your layouts or create a new category 

 

5. Click on the  create category button to create a new category 

6. Create category window will be displayed 

 

7. Give a name to the category and click on OK 



 

8. The category gets created and will be displayed in the drop down 

 

9. To save the layout click on the  save layout icon  

10. Save as Layout will be loaded 

 

11. Give a name to the layout  

 

12. Choose the Category in which you want to save the layout 



 

13. Click on the OK button 

14. The layout will be seen in the selected category and will be stored as per the number of Images 

on the page 

 

15. To add the Layout on a Template Page, simply double click on the layout and it gets loaded on 

the Page 

 



Creating Collages 

DG Foto Smart provides you with options to create beautiful collages from a set of Images or a Blank 

collage where you can add images to create a collage 

Creating Collages with Images 

This will create a Collage with the selected Images on Canvas. 

1. Consider the following page 

 

2. Select all the Images on the canvas page for which you want to create a Collage 



 

3. Click on the  Collage icon in the Effects Window.  



 

4. Click on the  Create Collage button.  

5. Alternately you can click on the  Insert Menu  

 

6. Select Collage 



 

7. Select the Create Collage option from the sub menu 

 

8. Collage gets created instantly 

 

9. Once the Collage is created you will see the selection color changing from Blue to Orange 

10. Also the Create Collage button changes to Break Collage in the Collage window 

 

 

 

 



Adding an Empty Collage 

With this option you can specify few basic details of Collage before adding any images. 

To add an Empty Collage 

1. Consider the following blank page where you want to create a collage 

 

2. Click on the  Insert Menu  

 

3. Select Collage 

 

4. Select the Add Collage option from the sub menu 

 

5. Add Collage window will appear 



 

6. Specify the Width and Height and click on the  Add button 

 

7. Notice that a Blank Collage container gets created on the Page. 

 

 

 

 



Adding Images to Collage 

Adding Single Photo 

1. Consider the following Template Page. 

 

2. Ensure that the Collage Container is selected 

 

3. Click on the  Photo Button to load the Photo Gallery 



 

4. Just double click on the Photo 

 

5. Notice the Photo gets added in the Collage Container 

 

6. Alternately, you can also drag and drop the photo in the collage container 

7. Select the Photo  



 

8. Drag and Drop the Photo inside the Collage Container 

 

9. You will see a + sign on the mouse pointer which means that the photo will be added in the 

Collage 



 

10. You can drag and drop as many Images you want in the collage 

 

Adding Multiple Images 

DG Foto Smart allows you to add multiple Images at one time in collage 

1. Consider the following Collage page 

 

2. Ensure that the collage is selected 



 

3. Select all the Images that you want to add in the collage in the photo gallery 

 

4. The selected photo will have an orange outline 

 

5. Click on the  Add to collage button  



 

6. The Images get added in the collage 

 

 

Changing the Collage Size 

DG Foto Smart provides you the option to change the collage size any time in the project as per your 

requirement  

1. Consider the Following Collage Page 



 

2. Select the Collage 

 

3. Now click on any of the 4 Coroners 

4. Keeping the Left Mouse key pressed, drag the mouse till the desired size is reached and release 

the mouse click 



 

5. The Collage Gets resized as per your requirement 

 

Alternatively 

1. Select the Collage 



 

2. Click on the Collage Icon in the Effects Window to load the Collage Window 



 

3. You will see a Width and Height text boxes with the current size displayed. 

 

 

4. Type in the new size in the Width and Height Text Box. 

 

5. You can also select the Units from the drop down list 



 

6. You can also use the option  Width and Height chain to resize the Collage container 

proportionately  

7. Press Enter once done 

8. You will see that the size of the Collage Changes to the value added in the text box 

 

 

Moving a Collage 

To Move a collage 

1. Move the mouse pointer to the center of the page where you will see a white square 



 

2. Your mouse cursor will show a four arrow icon 

 

3. Keeping the Mouse press you can move the collage anywhere on the page and release the 

mouse at the location where you want to move it 



 

Spacing in Collage 

DG Foto Smart allows different spacing option in a collage 

Spacing between Images 

DG Foto Smart allows you to have equal spacing between Images. You can also increase or decrease the 

spacing between Images 

1. Consider the following Collage 

 



2. Ensure that the Collage is selected 

 

3. Now click on the  Collage Button in the Effects window to load the collage window 



 

4. You will see a section named Gap. 

 

5. Move the Slider either to the right or left to increase or decrease the Gap between Images. 

 

6. Alternately you can also type the size in the text box displayed next to the slider 

 



7. Notice that the Spacing between the Images changes as you move the slider or type in a Value in 

the Text box 

 

Vertical and Horizontal Spacing 

DG Foto Smart allows you to have specific spacing on top, bottom, left and right of the Collage 

1. Consider the following Collage Page 

 

2. Ensure that the collage is selected 



 

3. If you want to have spacing on top bottom and left right of the collage 

4. Click on the  Collage button in the Effects Window to load the Collage window 



 

5. Notice a Vbuffer slider 

 

6. Change the Vbuffer slider to increase the Top and Bottom Spacing.  

 

7. You can also add a Value to the  Text Box 

8. Notice the change in spacing 



 

9. Similarly you can change the  Hbuffer slider to increase the 

Left and Right Spacing.  

10. To reset the change made, simply click on the  Reset button 

Applying different Properties on Collage 

DG Foto Smart allows you to apply different properties to the entire collage or a single photo in a collage 

Applying properties to all Images in collage 

You can apply the following Properties. 

Kindly refer to the respective properties on to know how to apply these feature to Objects 

Consider the following Collage Page 



 

1. Outline : You can apply inside outline and its preset.  

 

2. Glow : You can apply Inner and Outer Glow and its preset 



 

3. Shadow : You can apply shadow and its properties 

 

4. Filters : You can apply different filters  

 Blur  



 

 Sharpen  

 

 

 Opacity  



 

5. Effects : You can apply different effects to all the Images in collage  

 

6. Adjust: You can also do overall changes for 

 Brightness  



 

 Hue  

 

 Contrast  



 

 Saturation  

 

 Cyan-Red  



 

 Magenta-Green  

 

 Yellow-Blue  



 

 Black and White  

 

7. Frames: You can apply frames 

8. Masks : You can apply Masks 



 

Changing the Radius of Images 

DG Foto Smart allows you to apply round edges to Images. This can be achieved by changing the radius 

of Images 

1. Consider the following template page 

 

2. Select the Collage 



 

3. Click on the  Collage button in the effects window to load the Collage window 



 

4. There will be a Radius option provided 

 

5. Move the slider of the radius to the desired value 

 

6. You can also type the value in the text box  

7. Notice the edges of the Images changed 



 

8. To reset the changes, click on the  Reset button 

 

 

Selecting individual Images in a collage 

When a collage is created you can apply properties to the entire collage. But if you want to select an 

individual Photo in collage to add some properties, kindly follow the below step 

1. Consider the following collage page 



 

2. Select the Collage 

 

3. Click on the  Collage Icon in the Effects window to load the collage window 



 

4. Now click on the  Collage button. 

 

5. Alternately you can also click on the  collage icon in the content toolbar 

 

6. Notice that a Photo is selected with a Yellow Outline 



 

7. Now you can select individual Images in a collage and apply properties to it 

 

8. To exit from this mode and go back to the collage mode where the entire collage is selected. 

Click on the  Object Icon. 

 



9. You can also click on the  Object Icon in the content toolbar 

 

10. Notice the Entire collage is active and individual Images cannot be selected 

 

 

Shuffling Images inside collage 

DG Foto Smart provides you with a Shuffle feature where the Images inside the collage rearrange itself 

automatically without changing any properties 

1. Consider the following collage page 



 

2. Select the Collage 

 

3. Click on the  Collage Icon in the Effects window to load the collage window 



 

4. Click on the  Shuffle Button 

 

5. Notice the Images get rearranged in the collage 



 

 

Adjusting the Ratio of Images size in a Collage 

DG Foto Smart also allows you to change the ratio of the Photo size in a Collage 

1. Consider the following collage page 

 

2. Select the Collage 



 

3. Click on the  Collage icon in the Effects Window to load the Collage window 

 

4. Click on the drop down next to the Ration  and select the desired 

ration 

 

5. The changes as per the selection are mentioned below 

 Original : The images are by default in the Original state 



 

 3:2 : The Images get loaded in a 3:2 ration 

 

 1:1  : The Images get loaded in 1:1 Ration  



 

 

Understating the Fill Option 

DG Foto Smart provides you to change the way Images get filled in a Collage. 

1. Consider the following collage page 

 

2. Select the Collage 



 

3. Click on the  Collage icon in the Effects Window to load the Collage window 

4. Select the Drop down list next to the Fill  and Select the desired fill 

option from the List 

 

5. The changes as per the selection are mentioned below 

 Fit : This option is selected by default. It fits the Images inside 

the collage container 



 

 Fill : It fills the Images in the entire collage container 

 

 Random : It randomly adjust the Images to fill the entire collage 

container 



 

 

 

Changing or modifying the Collage Layout 

The layout of a collage is in Rows and Columns 

DG Foto Smart allows you the option to specify whether you want the Images to be added in Rows or 

Columns. It also lets you choose the number of rows and columns you want in a collage 

Adding Images in Rows 

1. Consider the following Collage Page 



 

2. Select the Collage 

 

3. Click on the Collage Button  in the Effects Window to load the Collage window 



 

4. Select  Rows button next to the Layout section. By default the Images are arranged in Rows 

 

5. Now add a Photo to a collage 

6. Notice that the Photo Gets added in a Row and not in Column 



 

Adding Images in Columns 

1. Consider the following Collage Page 

 

2. Select the Collage 



 

3. Click on the  Collage Button in the Effects Window to load the collage window 



 

4. Select  Columns button next to the Layout  

 

5. The color of the Icon changes to Orange  

6. Notice that the Images in the collage gets adjusted in Columns 



 

7. Now add a Photo to a collage 

8. Notice that the Photo Gets added in a Column and not in Row 

 

 

 



Changing the Number of Rows or Columns 

As per the selection in the Layout whether it is Rows or Columns, the number of Rows or Column gets 

displayed below 

DG Foto Smart provides you the option to change the Number of Rows or Columns 

1. Consider the Following Collage Page 

 

2. Select the collage 

 



3. Click on the  Collage Icon in the Effects window to load the Collage window 

 

4. Select the Layout whether you want it in Rows or Columns 

 

5. Based on the selection of Rows or Columns you will see the number of rows or columns 

 



6. Notice that the collage has 2 Rows 

 

7. Now type the number of Rows/Columns you want in a collage 

 

8. Notice that the collage changes to the specified number of Rows or Columns 

 

 

Specifying the number of Images in a Row or Column 

Just below the Section where the number of Rows or Columns are specified, you will see a Box where 

the specific number of Rows or Columns with the number of Images in a Row or Column is displayed 

DG Foto Smart allows you the option to specify how many Images you would like to have in a specific 

row or Column. 

This row or column goes on increasing or decreasing as you increase or decrease the number of Rows or 

Columns 

To Specify the Number of Images in a Row or Column follow the following steps 

1. Consider the Following Collage Page 



 

2. Select the Collage 

 

3. Click on the  Collage Icon in the Effects Window to load the Collage window 



 

4. You will see the number of Images in a Row or Column mention 

 

5. This will be based on the type of Layout viz. Rows or Columns  selected.  

6. Based on the Layout selection it will also show the number of rows or columns 

 

7. Change the Value of the number of Images in the respective rows or columns 



 

8. The number of Images get adjusted accordingly 

 

9. Notice the number of Images changes in a row or column as per the value specified on the page 

 

 

 Collage Rotation 

DG Foto Smart allows you to rotate the Entire Collage, Auto Rotate all the Images inside the Collage 

Rotate Entire Collage 



DG Foto Smart Art allows you to Rotate the Entire Collage 

1. Consider the following Collage Page 

 

2. Select the collage which you want to rotate 

 

3. You will see a  rotation icon on top of the Collage 

4. Click the Rotation icon and rotate the Collage as per your requirement. Release the mouse when 

the required rotation is reached 



 

5. The collage gets rotated 

 

 

Auto Rotate Images inside Collage 

DG Foto Smart provides you an auto rotate function. You can auto rotate Images inside a collage 

1. Consider the Following Collage Page 



 

2. Select the Collage 

 

3. Click on the  Collage Icon in the Effects Window to load the collage window 



 

4. Click on the  Rotate button 

 

5. Notice that the Images inside the Collage get rotate 



 

6. Every time you click on the rotate button the Images inside the collage will rotate  

 

Resetting the Auto Rotate 

You also have the option to reset the Auto Rotation 

1. Consider the Following Collage Page where Auto Rotation is applied 



 

2. Select the Collage 

 

3. Click on the  Collage Icon in the Effects Window to load the Collage window 



 

4. Click on the  Reset button 

 

5. All the Images will get reset 



 

 

Adding a Background Color to the Collage 

DG Foto Smart allows you to add a Solid Background Color 

1. Consider the Following Collage Page 

 

2. Select the Collage 



 

3. Click on the  Collage Icon in the Effects Window to load the Collage Window 



 

4. Click on the Color button next to Background 

 

5. Select Color Window will open 



 

6. Select the desired color. You can also use the  Color picker to select any color on the screen  

 

7. The Selected color gets displayed Under the New Label 



 

8. Click on the  OK button 

9. Notice the color in the box next to the background changes to the selected color 

 

10. Now Move the opacity slider below the Background button to change the opacity. BY default the 

opacity is set to zero. 

 

11. As you go on moving the slider for opacity the color on the background appears behind the 

collage 

 

12. You can also type in the value for the Opacity in the text box next to the slider  

13. You will see the changes immediately  



 

14. You can click on the  reset button to reset the Opacity and the Background Color 

Closing or Exiting the Collage Mode 

If you want to exit the collage mode follow the steps below 

1. Consider the following template page 

 

2. Select the collage 



 

3. Click on the  Break icon in the Content toolbar 

 

4. Notice that the collage container selection disappears 

5. You can also select individual Images and move it anywhere on the page 

 



6. Also when you add a photo by double clicking or drag and drop, it no more gets added in a 

collage pattern. 

 

Album Preview 

DG Foto Smart provides you the option to preview your projects so that you can have a look at the 

project pages before going for Export and Printing 

 

1. Ensure that a project is open 

 

2. Click on the View Menu 

 

3. Select Preview 



 

4. Alternately, you can also click on the  preview icon on the right hand side of the screen 

5. This will open the Album Preview Window.  

6. You will see a progress bar of Generating Preview 

7. Once the Preview is generated you will see you project with Navigation button and a Progress 

Slider 

 



8. Click on the Play button. The Preview of your project will start and the pages will be flip 

automatically 

 

9. You can also see the Page Name on the Slider which is being displayed on the screen 

 

10. Alternatively you can also scroll through the pages by clicking the  Previous or the 

 Next Button 

11. To close the Album preview window, click on the  Close Preview button. 

 

Exporting Pages 

DG Foto Smart allows you to simultaneously export multiple template pages as flat images in different 

standard graphic formats like JPG. It allows you to customize the export DPI as per the requirements of 

the Digital Labs or any printer. You can share these flat images by sending to friends, relatives or clients 

via the Internet.  

Exporting of Pages consists of the following  

 Sending Pages for Approval 

 Flattening Image(Open format) 

 The Split Option in Export 

 

 

Sending Pages for Approval 

Before you flatten or convert the design pages into a printable format. The designed pages should be 

approved by the customer 

mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/Flattening_Images.htm
mk:@MSITStore:G:/SmartLab/Help%20File/Dg%20Foto%20Art%20Gold_4928.chm::/The_Split_Option_in_Export_.htm


DG Foto Smart provides you with the option to send the designed pages to your customer for approval 

To create files for approval, consider that all the album pages have been designed 

1. Consider the following screen where the Album which you want to send for approval is opened 

in DG Foto Smart 

 

2. Click the   Export Project button on the standard toolbar. 

 

3. The DG Foto Smart Exporter window is displayed. 



 

4.  All the pages are selected, by default. The selection is indicated in Green Check Mark 

 

5. You can also individually select the pages to export by keeping the SHIFT key pressed and 

selecting the pages to Export 

 

6. The Exporter window will also show the Project Information 



 

4. Select Approval option 

 

5. The location of saving the Approval Pages is set by default.  

 

6. You can change it by clicking on the   Browse folder button and selecting a different 

location for saving the flattened images. 

7. Choose the File Format drop-down list 

 

 

12. Click the  Export button to begin flattening of the images. 

14. A Progress bar is displayed showing the progress of Export 



 

16. Once the Export is completed you will receive a successful message(Insert SS) 

17. The Exported pages will be saved in a folder which gets created automatically with the Name of 

the Project_date_time in the path selected to export page 

18. The message window will also mention the path where the exported pages are saved and 

provides you with the option to view the Exported Pages.  

19. Click on the  Yes button to view the pages 

20. It will open the folder where the Approval Pages are save 

21. These files are of very low resolution 

22. All the Images used in the designed pages will have a watermark. 

23. These watermark will be useful for your customer to mark the changes 

24. Once the changes have been confirmed, you can convert these pages into a high resolution 

printable files 

 

Flattening Images (Open Format) 

DG Foto Smart allows you to simultaneously export multiple template pages as flat images/printable 

formats like JPEG. 

 

1. Let us assume that you have an entire project ready with all the pages completed and ready for 

printing. 



 

2. Click the   Export Project button on the standard toolbar. 

 

3. The DG Foto Smart Exporter window is displayed. 



 

4.  All the pages are selected, by default. The selection is indicated in Green Check Mark 

 

5. You can also individually select the pages to export by keeping the SHIFT key pressed and 

selecting the pages to Export 

 

6. The Exporter window will also show the Project Information 



 

7. The location of saving the Flattened Pages is set by default.  

 

8. You can change it by clicking on the   Browse folder button and selecting a different 

location for saving the flattened images. 

9. Select Printable File format option 

 

10. Choose the File Format drop-down list, select the file type for flattening the image. 

 

 

11. Click any of the preset Export DPI buttons to select the Export DPI to match your digital labs 

requirements. 

 

12. You can also customize the DPI settings. 

 



13. Check the Custom DPI check box and enter an appropriate value into the Custom DPI text box. 

 

14. Click the  Export button to begin flattening of the images. 

15. A Progress bar is displayed showing the progress of Export 

 

16. Once the Export is completed you will receive a successful message 

 

17. The Exported pages will be saved in a folder which gets created automatically with the Name of 

the Project_date_time in the path selected to export page 

 

18. The message window will also mention the path where the exported pages are saved and 

provides you with the option to view the Exported Pages.  

19. Click on the  Yes button to view the pages 

20. It will open the folder where the Exported Pages are save 



 

21. You also have the option to abort the export process by clicking the Cancel button 

22. You will get a message window stating the Export has been cancelled. The export process will 

Export the page on which you had clicked cancelled. You can also view the pages in windows 

explorer by clicking the Yes 

 

 

The Split Option in Export(Currently unavailable) 

DG Foto Smart provides an option to split the template page into exactly two flattened images of equal 

halves after export. This feature is very useful especially while creating panoramic premium photo 

albums to ensure that the album pages are cut exactly at the center so as to appear as a single piece in 

the final album. This feature also gives you an advantage when your album page size is not supported by 

the digital lab. 



 

1. Let us assume that you have an entire project ready with all the pages completed and ready for 

printing. 

 

2. Click the   Export Project button on the standard toolbar. 

 

3. The DG Foto Smart Exporter window is displayed. 



 

4.  All the pages are selected, by default. The selection is indicated in Green Check Mark 

 

5. You can also individually select the pages to export by keeping the SHIFT key pressed and 

selecting the pages to Export 

 

6. The Exporter window will also show the Project Information 



 

7. The location of saving the Flattened Pages is set by default.  

 

You can change it by clicking on the   Browse folder button and selecting a different location for 

saving the flattened images. 

8. Check the   Split check box to split the template page into exactly two flat images of equal 

halves. 

 

9. You can also specify the Binding value in the text box  

10. Select Printable File format option 

 

11. Choose the File Format drop-down list, select the file type for flattening the image. 

 



 

 

12. Click any of the preset Export DPI buttons to select the Export DPI to match your digital labs 

requirements. 

 

13. You can also customize the DPI settings. 

 

14. Check the Custom DPI check box and enter an appropriate value into the Custom DPI text box. 

 

15. Click the  Export button to begin flattening of the images. 

16. A Progress bar is displayed showing the progress of Export 

 

17. Once the Export is completed you will receive a successful message 



 

18. The Exported pages will be saved in a folder which gets created automatically with the Name of 

the Project_date_time in the path selected to export page 

 

19. The message window will also mention the path where the exported pages are saved and 

provides you with the option to view the Exported Pages.  

20. Click on the  Yes button to view the pages 

21. It will open the folder where the Exported Pages are save 

22. You can see that a single page gets split into 2 

23. You also have the option to abort the export process by clicking the Cancel button 

24. You will get a message window stating the Export has been cancelled. The export process will 

Export the page on which you had clicked cancelled. You can also view the pages in windows 

explorer by clicking the Yes 

 

 

  

  

 



 Closing the Album/Project 

The Album or Project can be closed by selecting the Close Project option under the  File menu. It 

will ask for a confirmation before deleting. 

 

 

The album can also be closed by clicking the   Home button provided in the toolbar. 

   

  

Backup/Restore Project 

 

  

DG Foto Smart offers you Backup/Restore Project function. With this unique function you can take 

backup of your project(s). This project(s) can be restored on any computer for future use. 

  

Let us see how to take backup of project and how to restore that project. 

  

Taking Backup of Project(s) 

1. Open a project in DG Foto Smart . 



 
  

2. To take the backup of ongoing project, click the  Help menu from menu bar. 

 

3. From the Help menu click the  Backup Projects sub menu. 

 
  

4. You will get the Window to select a directory 



 

 

  

5. Create a folder with the Project Name and Select it  



 

  

6. Click the  Select Folder button to begin the backup procedure. 

7. Notice that the 'Backing up the project' status bar indicates the backup status. 

 
 



 

  

8. You will be intimated with a Popup Message After successful Backup  

  

Restoring the project 

  

1. To restore the backup project, start the DG Foto Smart application. 

  

2. From the menu bar click the  Help menu. 

 

3. From Help menu, click the  Restore Project  

4. A window will be opened to select the Directory to Restore 



 

5. Browse and select the Main folder where the backup project is and Click on  

Select folder button 

 

6. A progress window will be displayed 

 

7. Once the Restore of Project is completed you will see the Restored Project in the Home Screen 

under All Project  



Updating the Software 

DG Foto Smart will regularly release updates/upgrade to fix bugs or implement new features. It is very 

important to keep the software updated to get the new features or fixes 

1. Click on the  Help button on the Menu Bar 

 

2. Click on the Check for Updates 

 

3. If the Update is available, you will receive the below message 

 

4. Click the  Yes button 

5. A window will open to choose the location for saving the update 



 

6. Choose the location and click on the save button 



 

7. You will see a window with the progress of saving updates 

 

8. You will receive a confirmation window once the file is downloaded 



 

9. Click on the  Yes button to install the software 

10. The software will close and the installation will start 

11. You will receive a message once the update is complete 

12. You can check if the update is successful by clicking on the help menu and selecting about 

 

13. It will display the latest version of the software 

 



 

 


